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WARRANTY
The Anritsu products listed on the title page is warranted against defects in materials and workmanship
for three years from the date of shipment.
Anritsu’s obligation covers repairing or replacing products which prove to be defective during the
warranty period. Buyers shall prepay transportation charges for equipment returned to Anritsu for
warranty repairs. Obligation is limited to the original purchaser. Anritsu is not liable for consequential
damages.

LIMITATION OF WARRANTY
The foregoing warranty does not apply to Anritsu connectors that have failed due to normal wear. Also,
the warranty does not apply to defects resulting from improper or inadequate maintenance,
unauthorized modification or misuse, or operation outside of the environmental specifications of the
product. No other warranty is expressed or implied, and the remedies provided herein are the Buyer’s
sole and exclusive remedies.

DISCLAIMER OF WARRANTY 
DISCLAIMER OF WARRANTIES. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE
LAW, ANRITSU COMPANY AND ITS SUPPLIERS DISCLAIM ALL WARRANTIES, EITHER
EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WITH REGARD TO THE
PRODUCT. THE USER ASSUMES THE ENTIRE RISK OF USING THE PRODUCT. ANY LIABILITY
OF PROVIDER OR MANUFACTURER WILL BE LIMITED EXCLUSIVELY TO PRODUCT
REPLACEMENT.
NO LIABILITY FOR CONSEQUENTIAL DAMAGES. TO THE MAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW, IN NO EVENT SHALL ANRITSU COMPANY OR ITS SUPPLIERS BE LIABLE
FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES WHATSOEVER
(INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS,
BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY OTHER PECUNIARY
LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE THE PRODUCT, EVEN IF ANRITSU
COMPANY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME
STATES AND JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF
LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY
NOT APPLY TO YOU.

TRADEMARK ACKNOWLEDGMENTS
LMR Master and easyMap Tools are trademarks of Anritsu Company. NXDN is a trademark of Icom
Incorporated and JVC KENWOOD Corporation. MotoTRBO is a trademark Motorola Trademark
Holdings, LLC. VxWorks is a registered trademark, and WindML is a trademark of Wind River Systems,
Inc. Google Earth is a trademark of Google Inc. Windows is a registered trademark of Microsoft
Corporation.

NOTICE
Anritsu Company has prepared this manual for use by Anritsu Company personnel and customers as a
guide for the proper installation, operation and maintenance of Anritsu Company equipment and
computer programs. The drawings, specifications, and information contained herein are the property of
Anritsu Company, and any unauthorized use or disclosure of these drawings, specifications, and
information is prohibited; they shall not be reproduced, copied, or used in whole or in part as the basis
for manufacture or sale of the equipment or software programs without the prior written consent of
Anritsu Company.

UPDATES
Updates, if any, can be downloaded from the Documents area of the Anritsu Website at:
http://www.anritsu.com 

For the latest service and sales contact information in your area, please visit:
http://www.anritsu.com/contact.asp

http://www.anritsu.com
http://www.anritsu.com/Contact.asp


 





CE Conformity Marking

Anritsu affixes the CE Conformity marking onto its conforming products in accordance with 
Council Directives of The Council Of The European Communities in order to indicate that 
these products conform to the EMC and LVD directive of the European Union (EU).

C-tick Conformity Marking

Anritsu affixes the C-tick marking onto its conforming products in accordance with the 
electromagnetic compliance regulations of Australia and New Zealand in order to indicate 
that these products conform to the EMC regulations of Australia and New Zealand.

Notes On Export Management

This product and its manuals may require an Export License or approval by the government 
of the product country of origin for re-export from your country.

Before you export this product or any of its manuals, please contact Anritsu Company to 
confirm whether or not these items are export-controlled.

When disposing of export-controlled items, the products and manuals need to be broken or 
shredded to such a degree that they cannot be unlawfully used for military purposes.

Mercury Notification

This product uses an LCD backlight lamp that contains mercury. Disposal may be regulated 
due to environmental considerations. Please contact your local authorities for disposal or 
recycling information.

Perchlorate Material – Special Handling May Apply

Notification for California customers: this product uses a small Lithium battery installed 
internally on the circuit board that may contain perchlorate. Disposal may be regulated due 
to environmental considerations. Please contact your local authorities for disposal or 
recycling information. For information, see: 
http://www.dtsc.ca.gov/hazardouswaste/perchlorate/
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Safety Symbols

To prevent the risk of personal injury or loss related to equipment malfunction, Anritsu 
Company uses the following symbols to indicate safety-related information. For your own 
safety, please read the information carefully before operating the equipment.

Symbols Used in Manuals

Safety Symbols Used on Equipment and in Manuals
The following safety symbols are used inside or on the equipment near operation locations to 
provide information about safety items and operation precautions. Ensure that you clearly 
understand the meanings of the symbols and take the necessary precautions before operating 
the equipment. Some or all of the following five symbols may or may not be used on all 
Anritsu equipment. In addition, there may be other labels attached to products that are not 
shown in the diagrams in this manual.

Danger

This indicates a risk from a very dangerous condition or procedure that 
could result in serious injury or death and possible loss related to equipment 
malfunction. Follow all precautions and procedures to minimize this risk.

Warning This indicates a risk from a hazardous condition or procedure that could 
result in light-to-severe injury or loss related to equipment malfunction. 
Follow all precautions and procedures to minimize this risk.

Caution

This indicates a risk from a hazardous procedure that could result in loss 
related to equipment malfunction. Follow all precautions and procedures to 
minimize this risk.

This indicates a prohibited operation. The prohibited operation is indicated 
symbolically in or near the barred circle.

This indicates a compulsory safety precaution. The required operation is 
indicated symbolically in or near the circle.

This indicates a warning or caution. The contents are indicated symbolically 
in or near the triangle.

This indicates a note. The contents are described in the box.

These indicate that the marked part should be recycled.
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For Safety

Warning Always refer to the operation manual when working near locations at 
which the alert mark, shown on the left, is attached. If the operation, 
etc., is performed without heeding the advice in the operation 
manual, there is a risk of personal injury. In addition, the equipment 
performance may be reduced. Moreover, this alert mark is sometimes 
used with other marks and descriptions indicating other dangers.

Warning

When supplying power to this equipment, connect the accessory 
3-pin power cord to a 3-pin grounded power outlet. If power is 
supplied without grounding the equipment, there is a risk of receiving 
a severe or fatal electric shock.

Warning

This equipment can not be repaired by the operator. Do not attempt to 
remove the equipment covers or to disassemble internal 
components. Only qualified service technicians with a knowledge of 
electrical fire and shock hazards should service this equipment. 
There are high-voltage parts in this equipment presenting a risk of 
severe injury or fatal electric shock to untrained personnel. In 
addition, there is a risk of damage to precision components.

Caution

Electrostatic Discharge (ESD) can damage the highly sensitive 
circuits in the instrument. ESD is most likely to occur as test devices 
are being connected to, or disconnected from, the instrument’s front 
and rear panel ports and connectors. You can protect the instrument 
and test devices by wearing a static-discharge wristband. 
Alternatively, you can ground yourself to discharge any static charge 
by touching the outer chassis of the grounded instrument before 
touching the instrument’s front and rear panel ports and connectors. 
Avoid touching the test port center conductors unless you are 
properly grounded and have eliminated the possibility of static 
discharge.

Repair of damage that is found to be caused by electrostatic 
discharge is not covered under warranty.

Warning This product is supplied with a rechargeable battery that could 
potentially leak hazardous compounds into the environment. These 
hazardous compounds present a risk of injury or loss due to 
exposure. Anritsu Company recommends removing the battery for 
long-term storage of the instrument and storing the battery in a 
leak-proof plastic container. Follow the environmental storage 
requirements specified in the product technical data sheet.
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Chapter 1 — General Information

1-1 Introduction
This chapter provides information about frequency range, additional documents, 
general overview, preventive maintenance, and annual verification requirements for the 
Anritsu Handheld S412E LMR Master models. Available options are listed in 
Chapter 4, “Instrument Options”.

Throughout this manual, the terms LMR Master and S412E refer to the same instrument. 

1-2 Contacting Anritsu
To contact Anritsu, please visit:

http://www.anritsu.com/contact.asp 

From here, you can select the latest sales, select service, and support contact information in 
your country or region, provide online feedback, complete a “Talk to Anritsu” form to have 
your questions answered, or obtain other services offered by Anritsu. Updated product 
information can be found on the Anritsu web site:

http://www.anritsu.com/

Search for the product model number. The latest documentation is on the product page under 
the Library tab. Example URL for LMR Master S412E:

http://www.anritsu.com/en-us/products-solutions/products/s412e.aspx     

1-3 Available Models   
Table 1-1 lists the LMR Master models and frequency ranges that are described in this 
User Guide 

Table 1-1. LMR Master Models and Frequency Ranges

Model  Frequency Range

S412E Vector Network Analyzer: 500 kHz to 1.6 GHza

Spectrum Analyzer: 9 kHz to 1.6 GHzb

Signal Generator: 500 kHz to 1.6 GHz
NBFM Analyzer: 100 kHz to 1.6 GHzb 

a. Upper frequency range is 6 GHz with Option 16.

b. Upper frequency range is 6 GHz with Option 6.

http://www.anritsu.com/contact.asp
http://www.anritsu.com/
http://www.anritsu.com/en-us/products-solutions/products/s412e.aspx
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1-4 Additional Options
Additional options for the LMR Master are listed in Table 1-2. Most of these options are 
described in Measurement Guides (refer to Appendix A).

Table 1-2. LMR Master Models and Frequency Ranges

Model  Frequency Range

S412E-0006 6 GHz Spectrum Analyzer Frequency Extension

S412E-0010 Bias Tee

S412E-0015 Vector Voltmeter

S412E-0016 6 GHz VNA Frequency Extension

S412E-0019 High Accuracy Power Meter

S412E-0025 Interference Analyzer

S412E-0027 Channel Scanner

S412E-0031 GPS

S412E-0046 Fixed WiMAX RF Measurements

S412E-0047 Fixed WiMAX Demodulation

S412E-0066 Mobile WiMAX RF Measurements

S412E-0067 Mobile WiMAX Demodulation

S412E-0037 Mobile WiMAX Over-the-Air Measurements

S412E-0431 Coverage Mapping

S412E-0444 EMF Measurement (Requires Anritsu Isotropic Antenna)

S412E-0501 Distance Domain

S412E-0509 AM/FM/PM Analyzer

S412E-0521 P25/P25p2 Analyzer Measurements

S412E-0522 P25/P25p2 Coverage Measurements

S412E-0531 NXDN Analyzer Measurements

S412E-0532 NXDN Coverage Measurements

S412E-0541 LTE RF Measurements

S412E-0542 LTE Modulation Quality

S412E-0546 LTE Over-the-Air Measurements

S412E-0591 DMR 2 Analyzer Measurements

S412E-0592 DMR 2 Coverage Measurements

S412E-0721 PTC Analyzer Measurements

S412E-0722 PTC Coverage Measurements

S412E-0581 TETRA Analyzer Measurements

S412E-0582 TETRA Coverage Measurements
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1-5 Additional Documents
This user guide is specific to the LMR Master S412E and includes a general description of the 
instruments. Additional instrument functions and descriptions of optional measurement 
capabilities are described in measurement guides. 

Refer to Appendix A, “Measurement Guides” for a list of these guides and their Anritsu part 
numbers. Measurement guides are available on the document disc included with the 
instrument and for download (at no charge) from the Anritsu web site 
(http://www.anritsu.com). Refer to “Anritsu Reference Documents” on page 1-8.

General and performance specifications, instrument options, standard accessories, and 
optional accessories are described in the LMR Master Technical Data Sheet, (Anritsu part 
number 11410-00486).

1-6 Accessories 
The LMR Master Technical Data Sheet contains a list and description of available 
accessories. The data sheet is available on the documentation disc and the Anritsu web site.

1-7 General Description
The S412E LMR Master is an integrated multi-functional test instrument that eliminates 
the need to carry and learn multiple test sets. The S412E combines a high performance 
receiver/spectrum analyzer with a vector network analyzer. The S412E can optionally be 
configured to include Coverage Mapping for P25/P25p2, NXDN™, ETSI DMR Tier 2, 
MotoTRBO™, ITC-R PTC, and TETRA. Other available options include Interference 
Analyzer with mapping, Channel Scanner, AM/FM/PM Analyzer, Vector Voltmeter, Fixed 
and Mobile WiMAX™, FirstNet LTE (RF, Modulations, and Over-the-Air), Distance Domain 
for VNA, and High Accuracy Power Meter for terminating and inline USB sensors.

The S412E includes a CW and NBFM Signal Generator with a 500 kHz to 1.6 GHz frequency 
range and +0 dBm (1 mW) maximum power level. In the available LMR modes (P25/P25p2, 
NXDN, DMR 2, or ITC-R PTC) the S412E signal generator can create mode specific patterns, 
CW, 1 kHz AM, and 1 kHz FM signals with adjustable frequency and power levels.

The LMR Master spectrum analyzer, NBFM, P25/P25p2, NXDN, DMR 2, and PTC frequency 
ranges are expanded to 6 GHz with Option 6. The VNA frequency range is expanded to 6 GHz 
with Option 16. 

Additional options include a Bias Tee for TMA testing and a GPS receiver. Details on 
configuration and available options is provided in the LMR Master Technical Data Sheet.

The bright 8.4 inch TFT backlit LCD color display provides easy viewing in a variety of 
lighting conditions, and the combination of a touch screen and keypad enables you to navigate 
menus with the touch screen and to enter numbers with the keypad. All LMR Master models 
are equipped with a field-replaceable Li-Ion battery delivering more than three hours of 
battery life.

http://www.anritsu.com
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The internal memory is large enough to store approximately 2,000 traces or setups. External 
USB memory is limited only by the size of the attached USB memory device. Measurements 
and setups can also be stored in a USB flash drive or transferred to a PC by using the 
included USB cable. Use Line Sweep Tools (LST) for certain VNA measurements and Master 
Software Tools (MST) for spectral analysis measurements (refer to Chapter 6, “Anritsu PC 
Software Tools” for a brief overview of these software tools).

1-8 LMR Master Specifications
Refer to the LMR Master Technical Data Sheet (Anritsu part number: 11410-00486) for 
general specifications, detailed measurement specifications for all available measurement 
modes, ordering information, power sensors, and available accessories. The technical data 
sheet is included with the instrument, available on the documentation disc, and it is available 
on the Anritsu Website: http://www.anritsu.com 

1-9 Soft Carrying Case 
The LMR Master can be operated while in the soft carrying case. On the back of the case is a 
large storage pouch for accessories and supplies.

To install the instrument into the soft carrying case:

1. The front panel of the case is secured with hook-and-loop fasteners. Fully close the front 
panel of the case. When closed, the front panel supports the shape of the case while you 
are inserting the LMR Master.

2. Place the soft carrying case face down on a stable surface, with the front panel fully 
closed and laying flat.

3. Open the zippered back of the case.

Note

Not all after-market USB flash drives are compatible with the LMR Master. Many 
drives come with a second partition that contains proprietary firmware. This 
partition must be removed. Only one partition is allowed. Refer to the individual 
manufacturer for instructions on how to remove it. Some drives can be made to 
work by reformatting them using the FAT32 format.

Note

The soft case has two zippers near the back. The zipper closer to the front of the 
case opens to install and remove the instrument. The zipper closer to the back of 
the case opens an adjustable support panel that can be used to provide support for 
improved stability and air flow while the instrument is in the case. This support 
panel also contains the storage pouch.

http://www.anritsu.com
http://www.anritsu.com/en-US/Downloads/Brochures-Datasheets-and-Catalogs/Datasheet/DWL8712.aspx
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4. Insert the instrument face down into the case, take care that the connectors are 
properly situated in the case top opening. You may find it easier to insert the 
connectors first, then pull the corners over the bottom of the LMR Master.

5. Close the back panel and secure with the zipper to secure the LMR Master.

1-10 Tilt Bail Stand 
A Tilt Bail is attached to the back of the LMR Master for desktop operation. The tilt bail 
provides two settings of backward tilt for improved stability. To deploy the tilt bail, pull the 
bottom of the tilt bail away from the back of the instrument. To store the tilt bail, push the 
bottom of the bail towards the back of the instrument until it attaches to the LMR Master. 

Figure 1-1. LMR Master Inserted into the Soft Carrying Case 

Caution
The soft case has panel openings for the fan inlet and exhaust ports. Do not block 
the air flow through the panels when the unit is operating.

Note
Do not use the tilt bail while the instrument is in the soft case. The soft case has an 
adjustable support panel in the back zipper.
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1-11 Rack Mounting
The LMR Master can be mounted into a standard 19-inch EIA cabinet using Anrtisu’s Rack 
Mount Accessory kit (Anritsu part number: 66864).

The LMR Master is mounted in the universal bracket using the thin-case spacer and the 
compact-case brackets, both of which are included in the kit.

1-12 Preventive Maintenance 
LMR Master preventive maintenance consists of cleaning the unit and inspecting and 
cleaning the RF connectors on the instrument and on all accessories. Clean the LMR Master 
with a soft, lint-free cloth dampened with water or with water and a mild cleaning solution.

Clean the RF connectors and center pins with a cotton swab dampened with denatured 
alcohol. Visually inspect the connectors. The fingers of the N(f) connectors and the pins of the 
N(m) connectors must be unbroken and uniform in appearance. If you are unsure whether the 
connectors are undamaged, gauge the connectors to confirm that the dimensions are correct.

Visually inspect test port cables. The test port cable should be uniform in appearance and not 
stretched, kinked, dented, or broken.

Figure 1-2. Tilt Bail Extended 

Caution To avoid damaging the display or case, do not use solvents or abrasive cleaners.
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1-13 Calibration Requirements — Vector Network Analyzer
The LMR Master is a field portable unit operating in the rigors of the test environment. In 
order to ensure measurement accuracy, RF calibration (OSLT, for example) must be 
performed prior to making a measurement in the field.

The LMR Master has no field-adjustable components. The RF calibration components, 
however, are crucial to the integrity of the calibration and must be periodically verified to 
ensure their performance. This is especially important if the components have been dropped 
or over-torqued. 

1-14 Annual Verification 
Anritsu recommends an annual calibration and performance verification of the LMR Master 
and the OSL calibration components and InstaCal module by local Anritsu service centers.

The LMR Master is self-calibrating and has no field-adjustable components. The OSL 
calibration components are crucial to the integrity of the calibration. As a result, they must be 
verified periodically to ensure performance conformity. This is especially important if the 
OSL calibration components have been accidentally dropped or over-torqued. Contact 
information for Anritsu Service Centers is available at:

http://www.anritsu.com/Contact.asp

1-15 ESD Cautions    
The LMR Master, like other high performance instruments, is susceptible to ESD damage. 
Coaxial cables and antennas can easily build up a static charge, which (if allowed to discharge 
by connecting directly to the LMR Master without first discharging the static charge) may 
damage the instrument input circuitry. Operators must be aware of the potential for ESD 
damage and must take all necessary precautions.

Operators should exercise practices outlined within industry standards such as JEDEC-625 
(EIA-625), MIL-HDBK-263, and MIL-STD-1686, which pertain to ESD and ESDS devices, 
equipment, and practices. Because these standards apply to the LMR Master, Anritsu 
Company recommends that any static charges that may be present be dissipated before 
connecting coaxial cables or antennas to the LMR Master. This may be as simple as 

Note

For best calibration results (compensation for all measurement uncertainties), 
ensure that the calibration is performed at the end of the test port or optional 
extension cable (that is, at the same point that the device that is to be tested (DUT) 
will be connected). 

Caution 

For best results, use an Anritsu phase stable Test Port Extension Cable, such as 
those listed in the Technical Data Sheet for your instrument (refer to Appendix A). 
Use of a typical laboratory cable to extend the LMR Master test port to the device 
under test, or any bending of the cable subsequent to the OSL or OSLT calibration, 
may cause uncompensated phase reflections inside the cable. Reflections of this 
type cause measurement errors, which are more pronounced at higher frequencies.

http://www.anritsu.com/Contact.asp
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temporarily attaching a short or load device to the cable or antenna prior to attaching to the 
LMR Master. Remember that the operator may also carry a static charge that can cause 
damage. Following the practices outlined in these standards helps to ensure that a safe 
environment exists for both personnel and equipment.

1-16 Anritsu Reference Documents 
To find the LMR Master product pages, enter “LMR Master” in the search box on the Anritsu 
Web page: 

http://www.anritsu.com 

A table at the bottom of the LMR Master product Web page provides links to related 
literature and software. Examples include the following types of documents:

• Application Notes 

• Brochures 

• Data Sheets 

• Instruction Sheets 

• Measurement Guides

• Master Software Tools

• Line Sweep Tools

• easyMap Tools™

• Firmware Updates

• Digital LMR Control Channel Decoder scripts

1-17 Anritsu Service Centers    
For the latest service and sales information in your area, please visit the following URL:

http://www.anritsu.com/Contact.asp 

and choose a country for regional contact information.

http://www.anritsu.com
http://www.anritsu.com/Contact.asp
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1-18 Battery Replacement 
The battery can be replaced without the use of tools. The battery compartment is located on 
the lower left side of the instrument (when you are facing the measurement display). Refer to 
Figure 1-3. To remove the battery:

1. Slide the catch toward the bottom of the instrument.

2. Tilt the top of the door away from the unit.

3. Lift out the battery door.

4. Remove the battery pack from the instrument by grabbing the battery lanyard and 
pulling out.

Replacement is the opposite of removal. The battery key side (slot below the contacts) must be 
facing the front on the unit and slides in first. Press the battery inward firmly to seat the 
contacts, then reinstall the door. 

The battery that is supplied with the LMR Master may need charging before use. The battery 
can be charged while it is installed in the LMR Master by using either the AC-DC Adapter or 
the DC adapter, or outside the LMR Master with the optional Dual Battery Charger. Refer to 
“Battery Symbols” on page 2-13 for a description of battery symbols.

Note

When inserting the battery, the battery label must face the back of the instrument, 
and the guide slot on the battery must be below the contacts. If the battery door 
does not latch closed, the battery may be inserted incorrectly.

Figure 1-3. Battery Compartment
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1-19 Secure Environment Workplace 
This section describes the types of memory in the LMR Master, how to delete stored user files 
in internal memory, and recommended usage in a secure environment workplace.

LMR Master Memory Types

The instrument contains non-volatile disk-on-a-chip memory, EEPROM, and volatile DRAM 
memory. The instrument does not have a hard disk drive or any other type of volatile or 
non-volatile memory.

Disk-On-A-Chip (DOC)

DOC is used for storage of instrument firmware, factory calibration information, user 
measurements, setups, and *.jpg screen images. User information stored on the DOC is 
erased by the master reset process described in section “Erase All User Files in Internal 
Memory” on page 1-11.

EEPROM

This memory stores the model number, serial number, and calibration data for the 
instrument. Also stored here are the user-set operating parameters such as frequency range. 
During the master reset process, all operating parameters that are stored in the EEPROM 
are set to standard factory default values.

RAM Memory

This is volatile memory used to store parameters needed for the normal operation of the 
instrument along with current measurements. This memory is reset whenever the 
instrument is restarted.

External USB Flash Drive (not included with the instrument)

This memory may be selected as the destination for saved measurements and setups for the 
instrument. You can also copy the contents of the internal disk-on-chip memory to the 
external flash memory for storage or data transfer. The external USB flash drive can be 
reformatted or sanitized using software on a PC. 

Refer to the Chapter 4, “File Management” for additional information on saving and copying 
files to the USB flash drive.

Note

Use only Anritsu Company approved batteries, adapters, and chargers with this 
instrument.

Anritsu Company recommends removing the battery for long-term storage of the 
instrument.

Caution 

When using the Automotive Cigarette Lighter Adapter, always verify that the 
supply is rated for a minimum of 60 Watts at 12 VDC, and that the socket is clear 
of any dirt or debris. If the adapter plug becomes hot to the touch during operation, 
then discontinue use immediately.
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Erase All User Files in Internal Memory   

Perform a Master Reset:

1. Turn the instrument on.

2. If the Menu screen is displayed, press the Esc key.

3. Press the Shift button then the System (8) button.

4. Press the System Options submenu key.

5. Press the Reset key, then the Master Reset key.

6. A dialog box is displayed on the screen warning that all settings will be returned to 
factory default values and all user files will be deleted. 

7. Press the ENTER button to complete the master reset.

8. The instrument reboots, and the reset is complete.

Recommended Usage in a Secure Environment

Set the LMR Master to save files to an external USB flash drive:

1. Attach the external Flash drive and turn on the instrument.

2. Press the Shift button then the File (7) button.

3. Press the Save submenu key.

4. Press the Change Save Location submenu key, then select the USB flash drive with the 
rotary knob, Up/Down arrow keys, or the touchscreen.

5. Press the Set Location submenu key.

The external USB flash drive is now the default location for saving files.

Note

Not all after-market USB flash drives are compatible with the LMR Master. Many 
drives come with a second partition that contains proprietary firmware. This 
partition must be removed. Only one partition is allowed. Refer to the individual 
manufacturer for instructions on how to remove it. Some drives can be made to 
work by reformatting them using the FAT32 format.
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Chapter 2 — Instrument Overview 

2-1 Introduction
This chapter provides a brief overview of the Anritsu LMR Master. The intent of this chapter 
is to acquaint you with the instrument. For detailed measurement information, refer to a 
specific measurement guide listed in Appendix A, “Measurement Guides”. 

2-2 Turning On the LMR Master 
The Anritsu LMR Master is capable of approximately three hours of continuous operation 
from a fully charged, field-replaceable battery (refer to Section 1-18 “Battery Replacement” 
on page 1-9). 

The LMR Master can also be operated from an external power source (which also 
simultaneously charges the battery). This can be achieved with either the Anritsu AC-DC 
Adapter or the Automotive Cigarette Lighter Adapter. Both items are included with the 
LMR Master. 

To turn on the LMR Master, press the green On/Off button on the front panel (Figure 2-1). 
The LMR Master takes approximately sixty seconds to complete power warm-up and to load 
the application software. At the completion of this process, the instrument is ready for use. 

2-3 Front Panel Overview 
The LMR Master menu-driven interface is easy to use and requires little training. The 
LMR Master uses a touch screen and keypad for data input. The five bottom menu keys and 
eight submenu keys on the right side are touch screen keys. The menu and submenu keys 
vary depending upon the selected mode of operation. Refer to “Mode Selector Menu” 
on page 2-16.

Numeric keys 1 through 9 are dual purpose, depending upon the current mode of operation. 
The dual-purpose keys are labeled with a number on the key itself, and the alternate function 
is printed in blue above each of the keys. Use the blue Shift key to access the functions that 
are printed on the panel. The Escape key, used for aborting data entry, is the oval button 
located above numeric key 9. The rotary knob, the four arrow keys, and the keypad can be 
used to change the value of an active parameter. 

The Menu key provides graphical icons of all of the installed measurement modes and user 
defined shortcuts (refer to “Menu Key” on page 2-3). The locations of the keys are shown in 
Figure 2-1.

Caution 

When using the Automotive Cigarette Lighter Adapter, always verify that the 
supply is rated for a minimum of 60 Watts at 12 VDC, and that the socket is clear 
of any dirt or debris. If the adapter plug becomes hot to the touch during operation, 
discontinue use immediately. 
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Note
Keep the fan inlet and exhaust ports clear of obstructions at all times for proper 
ventilation and cooling of the instrument.

1 Instrument Settings Summary (unique to each trace). Many of displayed settings are used 
as menu shortcuts. Select a setting using the touch screen to display the menu and set the 
parameter for editing.

2 Fan Exhaust Port

3 Speaker

4 Rotary Knob

5, 12 Fan Inlet Port

6 Touch Screen Submenu Keys

7 Menu Key

8 Enter Key and Arrow Keys

9 Esc (Escape) Key

10 Shift Key

11 Numeric Keypad and Shift Menu Keys (printed in blue above 1 through 9) 

13 Charge LED

14 On/Off Button

15 Power LED

16 Touch Screen Main Menu Keys

Figure 2-1. LMR Master Overview
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Front Panel Keys

Menu Key

Press this key to display a grid of shortcut icons for installed measurement modes and any 
user-selected menus and setup files that may have been added. 

Figure 2-2 shows the Menu key screen with shortcut icons for the installed measurement 
modes. Touch one of the icons in the top row to change modes. These top-row icons are 
preinstalled and cannot be moved or deleted. 

Figure 2-2.  Menu Key Screen, Icons for Installed Measurements

Note

The display of the Menu screen varies depending on your LMR Master model and 
installed options.

Only the Esc key and the touch screen icons are functional in the Menu screen.

The instrument must be in a measurement mode to execute a function that is 
indicated in blue text above the number key. They do not function from the Menu 
screen. 
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Figure 2-3 shows the Menu key screen with shortcut icons for the installed measurement 
modes and four rows of user-defined shortcuts to menus and setup files. 

Press and hold down any touch-screen key for a few seconds to add a shortcut to this screen. 
To add shortcut setup files (*.stp), open the recall menu and hold down on the file name for 
several seconds. Then select the location for the shortcut. 

User-defined shortcuts stay in memory until deleted. To delete or move a shortcut button, 
press the Menu key, then press and hold the shortcut for approximately 3 seconds. The 
Customize Button dialog box opens to allow a button to be deleted or moved. Press Esc to exit 
the Menu shortcut display. 

Figure 2-3. Menu Key Screen with User-Defined Shortcuts

Note
The Factory Default reset deletes all user created shortcut icons from the Menu 
screen. Refer to the “Reset Menu” on page 5-12 for additional information.
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Help for the Menu shortcut screen is available by pressing the icon in the lower-right corner 
of the display. 

Esc Key 

Press this key to cancel any setting that is currently being made. 

Enter Key 

Press this key to finalize data input or select a highlighted item from a list.

Arrow Keys 

The four arrow keys (around the Enter key) are used to scroll up, down, left, or right. The 
arrow keys can often be used to change a value or to change a selection from a list. This 
function is similar to the function of the rotary knob. The arrow keys are also used to move 
markers. 

Shift Key 

Pressing the Shift key followed by pressing a number key executes the function that is 
indicated in blue text above the number key. When the Shift key is active, its icon is displayed 
at the top-right of the measurement display area near the battery charge indicator. 

Figure 2-4. Menu Help

Figure 2-5. Shift Key Icon
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Number Keypad 

The Number keypad has two functions: The primary function is number entry. The 
secondary function of the number keypad is to list various menus. 

Rotary Knob 

Turning the rotary knob changes numerical values, scrolls through selectable items from a 
list, and moves markers. Values or items may be within a dialog box or an edit window. 

Touch Screen Keys

Main Menu Touch Screen Keys  

These five main menu keys are horizontally arranged along the lower edge of the touch 
screen. The main menu key functions change to match specific instrument Mode settings. The 
main menu keys generate function-specific submenus. The various measurement modes are 
selected by pressing the Shift key and then the Mode (9) key. Descriptions of the various 
measurement modes can be found in the applicable Measurement Guides listed in 
Appendix A, “Measurement Guides”.

Submenu Touch Screen Keys 

These submenu keys are arranged along the right-hand edge of the touch screen. The 
submenu key labels change as instrument measurement settings change. The current 
submenu title is shown at the top of the submenu key block.

Keypad Menu Keys (1 to 9)

Pressing the Shift key followed by pressing a number key selects the menu function that is 
printed in blue characters above the number key. Refer to Figure 2-1 on page 2-2.

Not all Secondary Function Menus are active in various measurement modes. If any one of 
these menus is available in a specific instrument mode of operation, then it can be called from 
the number keypad. It may also be available from a main menu key or a submenu key. 

The Preset Menu (1) and System Menu (8) are described in Chapter 5, “System Operations ”. 
The Sweep Menu (3), Measure Menu (4), Trace Menu (5), and Limit Menu (6) vary depending 
on measurement mode, refer to the Measurement Guides listed in Appendix A for 
information. The File Menu (7) is described in Chapter 4, “File Management”. The Mode 
Menu (9) is described in “Mode Selector Menu” on page 2-16. 

LED Indicators

Power LED

The Power LED is located to the left of the On/Off key. The LED is solid green when the unit 
is on and slowly blinks when the unit is off but has external power.

Charge LED

The Charge LED is located to the right of the On/Off key. The LED slowly blinks when the 
battery is charging and is solid green when the battery is fully charged.

Note
Available measurement modes are based on model and options purchased. 
Refer to Table 1-1 and the Technical Data Sheet for additional information. 
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2-4 Display Overview  
Figure 2-6 illustrates some of the key information areas of the LMR Master sweep window in 
Vector Network Analyzer mode using “Field” menu structure. For detailed information, refer 
to the Measurement Guides that are listed in Appendix A, “Measurement Guides”. 

1 Trace 1 (TR1) data (within Instrument Settings Summary)

2 Instrument Settings Summary (applies to all traces)

3 Real Time Clock

4 GPS Icon

5 GPS location

6 Battery Charge indicator

7 Measurement description

8 Submenu Touch Screen Keys 

9 Main Menu Touch Screen Keys

Figure 2-6. Field Mode View VNA Display with GPS On

Note

Refer to “Field Mode Display vs. Standard VNA Display” on page 3-3 for 
information on the two LMR Master menu structures in VNA mode. 

Press Shift-8 (System) > Application Options > Meas Menu to toggle between the 
two structures. 

2 6 87

1

43 5

9
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Display Settings

In addition to the default color display, LMR Master offers the following display settings 
(System > System Options > Display) in some measurement modes:     

Black on White for printing and viewing in broad daylight conditions

Color on White exchanges black for white on the display for best color printing

Night Vision optimized for night-time viewing

High Contrast for other challenging viewing conditions 

Figure 2-7. LMR Master Display Settings 

Default Colors Black on White

Night Vision

High Contrast Color on White
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2-5 Test Panel Connector Overview 
Test panel connectors for the LMR Master S412E is shown in Figure 2-8. 

1 External Reference In

2 Audio In

3 External Trigger In

4 Signal Generator Out

5 RF In 

6 USB Mini-B (Full Speed, USB 2.0)

7 GPS Antenna (with Option 31)

8 External Power

9 USB Type A (Full Speed, USB 2.0)

10 3.5 mm Headset Jack

11 VNA Port 1 50 ohm

12 VNA Port 2 50 ohm

Figure 2-8. Test Panel Connectors

Note

This instrument is equipped with Type N connectors. To prevent damage, do not 
use pliers or a plain wrench. Do not over tighten. 

Recommended torque: 1.36 N·m to 1.70 N·m (12 lbf·in to 15 lbf·in).

Do not twist cable or accessory body. Rotate the coupling nut only.

1 2 3 4 5 76

10 812 11 9
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Test Panel Connectors

External Power 

The external power connector (refer to item “8” in Figure 2-8 on page 2-9) is used to power the 
unit and for battery charging. Input is 12 VDC to 15 VDC at up to 5.0 A. The green flashing 
Power LED indicates that the instrument has external power. 

USB Interface – Type A 

The LMR Master has two Type A USB connectors (refer to item “9” in Figure 2-8) that accept 
USB Flash Memory devices for storing measurements, setup data, screen images, and 
firmware updates.

USB Interface – Mini-B 

USB 2.0 Mini-B connector (refer to item “6” in Figure 2-8) can be used to connect the 
LMR Master directly to a PC, as shown in Figure 2-9. The first time the LMR Master is 
connected to a PC, the normal USB device detection by the computer operating system will 
take place. The CD-ROM that is shipped with the instrument contains a driver for 
Windows XP that is installed when Master Software Tools is installed. Drivers are not 
available for earlier versions of the Windows operating system. During the driver installation 
process, place the CD-ROM in the computer drive and specify that the installation wizard 
should search the CD-ROM for the driver.  

Warning 

When using the AC-DC Adapter, always use a three-wire power cable that is 
connected to a three-wire power line outlet. If power is supplied without grounding 
the equipment in this manner, then the user is at risk of receiving a severe or fatal 
electric shock.

Note
For proper detection, either Line Sweep Tools or Master Software Tools should be 
installed on the PC prior to connecting the LMR Master to the USB port.
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Headset Jack 

The headset jack provides audio output from the built-in AM/FM/SSB demodulator for testing 
and troubleshooting wireless communication systems. The jack accepts a 3.5 mm (1/8 inch) 
3-wire miniature phone plug such as those commonly used with audio headsets (refer to item 
“10” in Figure 2-8).

External Trigger In 

A TTL signal that is applied to the External Trigger In female BNC input connector causes a 
single sweep to occur. In the Spectrum Analyzer mode, it is used in zero span, and triggering 
occurs on the rising edge of the signal. After the sweep is complete, the resultant trace is 
displayed until the next trigger signal arrives (refer to item “3” in Figure 2-8).

External Reference In 

The BNC female connector (refer to item “1” in Figure 2-8) is used for connection of an 
external frequency reference. The amplitude of the External Reference should be between 
–10 dBm and +10 dBm.

RF In (50 ohm) 

This connector (refer to item “5” in Figure 2-8) provides the input 50 ohm interface for the 
Spectrum Analyzer function. With Option 10, Bias Tee, output is available on the center pin 
out of this port in Spectrum Analyzer mode.

GPS Antenna Connector (Option 31) 

The GPS antenna connection on the LMR Master is type SMA-female (refer to item “7” in 
Figure 2-8). The GPS function is described in Chapter 8, “GPS (Option 31) ”. 

Figure 2-9. LMR Master Connected to PC via USB Mini-B
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Audio In 

Audio In (refer to item “2” in Figure 2-8) is used to support SINAD and Quieting 
measurements of analog FM radio sensitivity.

Signal Generator Out 

Output of the built-in Signal Generator when the LMR Master is in CW, NBFM, P25/P25p2, 
NXDN, DMR 2, or PTC mode (refer to item “4” in Figure 2-8). Output is turned on with the 
Turn Sig-Gen ON main menu key. 

VNA Port-1 (50 ohm) 

This connector (refer to item “11” in Figure 2-8) provides the input/output 50 ohm interface 
for reflection measurements of the Vector Network Analyzer at Port 1.

VNA Port-2 (50 ohm) 

This connector (refer to item “12” in Figure 2-8) provides the input 50 ohm interface for 
transmission measurements of the Vector Network Analyzer at Port 2. With Option 10, 
Bias Tee, output is available on the center pin out of this port in VNA mode.

2-6 Symbols and Indicators
The following symbols and indicators indicate the instrument status or condition on the 
display.

The instrument settings that are unique to each trace are summarized in an information 
block on the left side of the measurement display screen (refer to Figure 2-6). Each block 
contains the trace number followed by the S-parameter or information that is assigned to that 
trace (TR4: S21, for example). If the trace has Trace Math applied to it, then the math 
function is also displayed on that line (TR1: S11/M1, for example), where M1 is the memory 
that is associated with TR1, and the math function is Trace/Memory). The S-parameter that 
is assigned to the trace memory is shown (if enabled) at the top of each trace information 
block (M1: S11, for example). Each trace block also includes the Graph type, the smoothing 
percentage, the calibration status, and the scale (Resolution per Division and the Reference 
Value). The calibration status indicates whether the calibration is ON, OFF, or non-existent 
(--) for the specific S-parameter that is assigned to each trace. If the Calibration is ON, then 
its validity is also displayed (OK,?, or X).

For calibration procedures refer to the Vector Network Analyzer Measurement Guide 
(PN: 10580-00289) listed in Appendix A. 
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Battery Symbols 

The battery symbol above the display indicates the charge remaining in the battery. 
The colored section inside the symbol changes size and color with the charge level.

Green with Black Plug body: Battery is fully charged and external power is applied

Green: Battery is 30 % to 100 % charged

Yellow: Battery is 10 % to 30 % charged

Red: Battery 0 % to 10 % charged

Lightning Bolt: Battery is being charged (any color symbol)

Detailed battery information is also available in the Status dialog box (System > Status).

When either the AC-DC Adapter or the Automotive Cigarette Lighter Adapter is connected, 
the battery automatically receives a charge, and the battery symbol with the lightning bolt is 
displayed (Figure 2-11). 

The green Charge LED flashes when the battery is charging, and remains on steady when the 
battery is fully charged. 

When operating from external power without a battery installed, the battery symbol is 
replaced by a red plug body (Figure 2-12). 

Figure 2-10. Battery Status

Figure 2-11. Battery Charging Icon

Caution Use only Anritsu-approved batteries, adapters, and chargers with this instrument.

Figure 2-12. Battery Not Installed
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Additional Symbols

Single Sweep 

Single Sweep is selected. Press Continuous in the Sweep menu to resume continuous 
sweeping.

Floppy Icon 

Shortcut to the Save submenu. Touch the icon to open the touch screen keyboard for saving 
measurements, setups, or screen displays.

2-7 Data Entry 

Numeric Values

Numeric values are changed using the rotary knob, arrow keys, or the keypad. Pressing one 
of the main menu keys displays a list of submenus on the right side of the touch screen. When 
the value on a submenu key is displayed in red, it is ready for changing. When using the 
rotary knob or arrow keys the changing value is shown on the submenu and in red on the 
graticule. When using the keypad, the new value is shown in red on the graticule and the 
submenu changes to Units. Selecting a unit for the new value completes the entry.

Parameter Setting

Pop-up list boxes or edit boxes are used to provide selection lists and selection editors. Scroll 
through a list of items or parameters with the arrow keys, the rotary knob, or the touch 
screen. These list boxes and edit boxes frequently display a range of possible values or limits 
for possible values.

Finalize the input by pressing the Enter key. At any time before finalizing the input, press the 
escape (Esc) key to abort the change and retain the previously existing setting.

Some parameters (such as for antennas or couplers) can be added to list boxes by creating 
them and importing them using Master Software Tools.

Figure 2-13. Floppy Icon
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Text Entry 

When entering text, as when saving a measurement, the touch screen keyboard is displayed 
(Figure 2-14). Characters are entered directly with the touch screen keyboard. The keypad 
can be used for numeric entry. The left and right arrow keys scroll the cursor through the 
filename. Refer to “Save Menu” on page 4-9 for additional information.

Figure 2-14. Touch Screen Keyboard
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2-8 Mode Selector Menu 
To access the functions under the Mode menu, press the Shift key, then the Mode (9) key. 
Use the directional arrow keys, the rotary knob, or the touch screen to highlight the selection, 
and press the Enter key to select. The list of modes that appear in this menu varies depending 
upon the options that are installed and activated in the instrument. Figure 2-15 is an 
example of the Mode menu. Your instrument may not show the same list. The current mode is 
displayed below the battery symbol. 

The Menu key is another option to quickly change measurement modes. Press the Menu key 
then select one of the Measurement icons in the top rows (Figure 2-2 on page 2-3). 

Figure 2-15. Mode Selector Menu 

Note The display of the Mode Selector varies depending on installed options.
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Chapter 3 — Quick Start Guide 

3-1 Introduction
This chapter provides a brief overview of basic measurement setups for several measurement 
modes. For detailed measurement information, refer to a specific measurement guide listed in 
Appendix A, “Measurement Guides”. This chapter provides quick start measurement 
information for the following measurement modes:

• Section 3-3 “CW Signal Generator” on page 3-2

• Section 3-4 “Vector Network Analyzer” on page 3-3

• Section 3-5 “Spectrum Analyzer” on page 3-9

• Section 3-6 “NBFM Analyzer” on page 3-14

• Section 3-7 “P25/P25p2, NXDN™, DMR 2, ITC-R PTC, or TETRA Signal Analyzer” 
on page 3-17

3-2 Measurement Mode Selection
Press the Menu key and use the touch screen to select the appropriate measurement icon.

Figure 3-1.  Menu Screen with Icons for Installed Measurement Modes

Note The display of the Menu screen varies depending on installed options.
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3-3 CW Signal Generator
The CW Signal Generator provides a continuous wave (CW) signal from the Signal Generator 
Out port of the LMR Master. The CW signal is primarily used for testing the sensitivity of 
receivers. To test receiver sensitivity, connect the output directly to the receiver that is being 
measured, and then reduce the signal generator amplitude until the receiver is unable to 
detect the signal.

1. Set the instrument to CW Signal Generator mode as described in the previous section.

2. Press the Freq main menu key and set the transmit frequency of the CW signal.

3. Press the Amplitude main menu key and set the Power Level and Offset. Add a positive 
value offset value for any external gain or negative offset value for any external loss.

4. Press the Turn Sign-Gen OFF main menu key to stop transmitting.

Note
CW Output is turned on by default when entering CW Signal Generator mode and 
automatically turned off when exiting CW Signal Generator mode.

Figure 3-2. CW Signal Generator
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3-4 Vector Network Analyzer
Set the instrument to Vector Network Analyzer (VNA) mode as described in Section 3-2.

Field Mode Display vs. Standard VNA Display

Field Mode is the default display of the LMR Master when the instrument is turned on for the 
first time or reset. Field Mode display may be more familiar to users who have experience 
making Cable and Antenna measurements using the Anritsu Site Master. Standard VNA 
display allows the full Vector Network Analyzer functionality of the LMR Master.

Press Shift-8 (System) > Application Options > Meas Menu to toggle between the two views. 
Figure 3-3 shows an example of typical VNA measurements in Field Mode Display and 
Standard VNA display. Refer to the Vector Network Analyzer Measurement Guide listed in 
Appendix A for detailed information on VNA measurements and the menu differences 
between the two display structures. 

Figure 3-3.  Measurement Menu in Field Mode Display and Standard VNA Display

Field Mode Display

Standard VNA Display
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Select the Measurement Type

Press the Measure main menu key and then the Measurement Type submenu key. Select a 
measurement graph and press Enter.

Set the Frequency 

1. Press the Freq/Dist main menu key.

2. Press the Start Freq submenu key and use the keypad, rotary knob, or the arrow keys to 
enter the start frequency.

3. Press the Stop Freq submenu key and use the keypad, rotary knob, or the arrow keys to 
enter the stop frequency.

Set the Scale 

1. Press the Scale main menu key.

2. For Smith Charts, select the appropriate zoom level. The graph expands or compresses 
around the central reference impedance of the Smith Chart

3. For other graphs, set the Top and Bottom of the scale or press Autoscale.

Turn On Markers 

1. Press the Marker main menu key.

2. Press the Marker submenu key to open the Select Marker list box and select a marker by 
scrolling with the rotary knob or the arrow keys, then press Enter. Unused markers are 
labeled OFF. The number on the Marker submenu key indicates the active marker.

3. Use the rotary knob, arrow keys, or touch and drag to move the Marker. The frequency 
of the active Marker is shown in the upper-left corner of the display screen.

Peak and Valley Search Markers    

When making measurements, the Peak Search and Valley Search features can be used to 
quickly place a Marker on a maximum or minimum point of a trace. 

1. With an active marker, press the Peak Search or the Valley Search submenu key to find 
the maximum or minimum value on the trace that is associated with the current 
marker.

Note
The following Quick Start instructions apply to VNA Field Mode. For detailed 
measurement instructions, refer to the Vector Network Analyzer Measurement 
Guide P/N 10580-00289, listed in Appendix A.
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Set Up Delta Markers   

If the intent is to conduct a delta measurement, then two markers are necessary: one to be the 
reference marker and one to be the delta marker. 

Delta Marker Setup:

1. Press the Marker main menu key.

2. Turn on Marker 1 (to be the Ref marker) and assign it to a trace. 

a. Press Marker and select MK1 from the list box. Then press Enter.

b. The Marker Type submenu key is set by default to Ref.

3. Turn on Marker 2 and change the Marker Type from Ref to Delta.

4. Assign Marker 2 to Marker 1 by pressing the Avail Ref Mkr submenu key to open the 
Select One list box. Scroll to choose MK1 and press Enter. 

Set a Single Limit Line 

1. Press Shift and then Limit (6) to enter the Limit menu.

2. Set Limit State to On. Press the Limit key to set the limit line to either Upper or Lower.

3. Use the numeric keypad, the arrow keys, or the rotary knob to change the limit value 
and then press Enter.

Note
The Marker list box includes the current location, readout style, and delta status 
(if they exist). Otherwise, it indicates Off.

Note

Limit lines are not available for Smith charts.

Refer to the Vector Network Analyzer Measurement Guide (listed in Appendix A) 
for creating multi-segment limit lines.
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4. Press the Limit Alarm key to turn on or off the Limit Alarm.

Set Up Distance Domain  

This option is fully described in the Vector Network Analyzer Measurement Guide. 
Refer to Appendix A, “Measurement Guides”. Measurement Guides are available 
on the documentation disc and as free downloads from the Anritsu Web site 
(refer to “Anritsu Reference Documents” on page 1-8).

Calibration Considerations 

Various calibrations are available in the LMR Master. Press Shift-2 (Calibration) to open the 
calibration menu. Press Start Cal and follow the instruction onscreen. 1-Port calibration is the 
simplest and requires three connections during calibration. 2-Port calibration requires 
four calibration connections and corrects for the transmit port match.

VNA calibration requires external precision OSL calibration components. 2-Port calibration 
also requires a through connector (Figure 3-5 on page 3-7).     

Figure 3-4. Single Limit Lines

Note

The Vector Network Analyzer Calibration menu is the same one that is used in the 
Vector Voltmeter menu (Option 15). Refer to section “Calibration Menus” in 
Chapter 6 of the Vector Network Analyzer Measurement Guide (refer to 
Appendix A) for more information about the calibration menu. Note that some 
calibration parameters are shared between the Vector Network Analyzer and 
Vector Voltmeter mode, and that some parameters are different because they were 
optimized for the specific mode application.
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When performing a calibration, the correction coefficients are calculated for specific 
measurements (depending on the type of calibration chosen) and for instrument settings 
(frequency range, number of points, and power level). The term “calibration correction” refers 
to the correction coefficients that are applied to measurements as a result of your calibration.

When calibration correction is On, the correction is applied to all applicable measurements. 
For example, if a 1-port calibration is performed, then only traces that measure reflection 
have a valid calibration. For those traces, the calibration information data in the Instrument 
Settings Summary (item 1 in Figure 2-6 on page 2-7) shows “CAL: ON (OK)”. Other traces 
that do not measure reflection display “CAL: --” to indicate that no valid calibration is 
available for those traces. The calibration correction can also be turned off manually under 
the Calibration menu by toggling the Cal Correction submenu key from On to Off. In that case, 
the display shows “CAL: OFF” for all traces that have valid correction data available. 

Note that “CAL: OFF” means that a calibration correction has been created, but it is not 
currently being used. This is different from “CAL: --”, which means that no valid calibration 
correction is available for the current setting.

1 Optional Test Port Cable at VNA Port 2

2 Optional Test Port Cable at VNA Port 1

3 OSL (Open, Short, Load) Precision Calibration Components

4 Through Connection for 2 Port Calibration (Port 1 Connects to Port 2)

Figure 3-5. Calibration

OPEN

SHORT

LOAD

1 2 3

4
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When you have Cal Correction on, you cannot increase the frequency range or the number of 
points. You can, however, reduce the frequency range or decrease the number of points 
without forcing the calibration to become invalid. When reducing the frequency range, the 
LMR Master uses the appropriate points within the new frequency range that have correction 
coefficients applied to them. In that case, you can observe that the number of points that are 
being used for calibration correction are automatically reduced. 

If you reduce only the number of points, then the frequency range is not changed. The 
LMR Master finds a subset of the original points in the sweep that can be used. You can 
therefore notice that the instrument may not use the exact number of points that you have 
entered. It picks a specific number of points that allow the calibration correction to continue 
to be valid. If you use the rotary knob, you will more easily find the available number of 
points that can be set. For example, if you calibrated with 201 points, then you can observe 
that you can reduce the number of points to 101, 68, 51, 41, and so forth. 

If you change the source power setting, the calibration status is changed to “CAL: ON (?P)”, 
which indicates that source power has changed since the instrument was calibrated (from 
Low to High, or from High to Low). In this case, the calibration may still be valid, but a new 
calibration is recommended.

Another status information display that you may see is “CAL: ON (?T)” which indicates that 
the instrument temperature has deviated by more than a set amount since the time that the 
calibration was conducted. The calibration is most likely still valid, but a new calibration is 
recommended. If you see “CAL: ON (X)” on the display, then this indicates that the 
instrument temperature has deviated (since the time the calibration was conducted) by an 
amount that has more than likely rendered the calibration invalid. When this occurs, a new 
calibration is highly recommended before further measurements are conducted.

Only one calibration is available at one time. Performing a new calibration overwrites any 
existing calibration. You can, however, store a measurement setup (with CAL), which also 
stores the calibration. You can therefore have multiple calibrations available (as long as the 
calibration settings and conditions continue to apply).

Existing Cal Info

The Cal Info submenu key is found in the Calibration main menu and lists the current 
calibration settings.
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3-5 Spectrum Analyzer
Set the instrument to Spectrum Analyzer mode as described in Section 3-2 “Measurement 
Mode Selection” on page 3-1.

Set Start and Stop Frequencies 

1. Press the Freq main menu key then the Start Freq submenu key.

2. Enter the desired start frequency using the keypad, the arrow keys, or the rotary knob. 
When entering a frequency using the keypad, the submenu key labels change to GHz, 
MHz, kHz, and Hz. Press the appropriate unit key. Pressing the Enter key has the same 
affect as pressing the MHz submenu key.

3. Press the Stop Freq submenu key and enter the desired stop frequency.

Enter the Center Frequency

1. Press the Freq main menu key.

2. Press the Center Freq submenu key.

3. Enter the desired center frequency using the keypad, the arrow keys, or the rotary knob. 
When entering a frequency using the keypad, the submenu key labels change to GHz, 
MHz, kHz, and Hz. Press the appropriate unit key. Pressing the Enter key has the same 
affect as pressing the MHz submenu key.

The center frequency and span is shown at the bottom of the screen.

Select a Signal Standard 

1. Press the Freq main menu key.

2. Press the Signal Standard submenu key. The Signal Standards dialog box opens.

3. Highlight a signal standard and press Enter to select.

4. Press the Channel submenu key to change the channel value in the Channel Editor.

The signal standard is shown in yellow at the top of the screen.

Set the Measurement Bandwidth 

1. Press the BW main menu key to display the BW menu.

• Press the RBW and/or the VBW submenu key to manually change the values.

• Set RBW and VBW automatically by pressing the Auto RBW submenu key or the 
Auto VBW submenu key.

2. Press the RBW/VBW submenu key to change the resolution bandwidth to video 
bandwidth ratio.

3. Press the Span/RBW submenu key to change the span width to resolution bandwidth 
ratio.

Note
The following Quick Start instructions apply to Spectrum Analyzer Mode. For 
detailed measurement instructions, refer to the Spectrum Analyzer Measurement 
Guide listed in Appendix A.
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Set the Amplitude 

Press the Amplitude main menu key to display the Amplitude menu.

Set Amplitude Reference Level and Scale

1. Press the Reference Level submenu key and use the arrow keys, rotary knob, or the 
keypad to change the reference level. Press Enter to set the reference level value.

2. Press the Scale submenu key and use the arrow keys, rotary knob, or the keypad to 
enter the desired scale. Press Enter to set the scale value.

Set Amplitude Range and Scale

1. The Auto Atten submenu key sets an optimal reference level based on the measured 
signal.

2. Press the Scale submenu key.

3. Enter the desired scale units by using the keypad, the arrow keys, or the rotary knob. 
Press Enter to set. The y-axis scale is automatically renumbered.

Power Offset Set Up for Compensating External Loss 

To obtain accurate results, compensate for any external attenuation by using power offset. 
In power offset mode, the compensation factor is in dB. (External attenuation can be created 
by using an external cable or an external high power attenuator.)

Press the RL Offset submenu key and use the keypad, the arrow keys, or the rotary knob to 
enter the desired offset value. When using the rotary knob, the value changes in increments 
of 0.1 dB. Using the Left/Right arrow keys changes the value in 10% increments of the value 
shown on the Scale submenu key. When using the Up/Down arrow keys, the value changes in 
the increment shown on the Scale submenu key. When using the keypad, enter the new value 
then press Enter or the dB submenu key to set the value. The power offset is displayed in the 
instrument settings summary column on the left side of the measurement display.

Set the Span 

1. Press the Span main menu key or the Freq main menu key followed by the 
Span submenu key.

2. To select full span, press the Full Span submenu key. Selecting full span overrides any 
previously set Start and Stop frequencies.

3. For a single frequency measurement, press the Zero Span submenu key.

Note
To quickly move the span value up or down, press the Span Up 1-2-5 or Span 
Down 1-2-5 submenu keys These keys facilitate a zoom-in, zoom-out feature in a 
1-2-5 sequence.
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Single Limit Line 

Press the Limit menu key to display the Limit menu.

1. Press the Limit (Upper / Lower) submenu key to select the desired limit line, 
Upper or Lower.

2. Activate the selected limit line by pressing the On Off submenu key so that On is 
underlined.

3. Press the Limit Move submenu key to display the Limit Move menu. Press the first 
Move Limit submenu key and use the arrows keys, rotary knob, or keypad to change the 
dBm level of the limit line.

4. Press the Back submenu key to return to the Limit menu.

5. If necessary, press the Set Default Limit submenu key to redraw the limit line in view.

Create a Limit Envelope

1. Press Shift then Limit (6) to open the Limit menu.

2. Press Limit Envelope.

3. Press the Create Envelope key.

Figure 3-6. Limit Envelope
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Setting Up Markers 

Press the Marker main menu key to display the Marker menu.

Selecting, Activating, and Placing a Marker

1. Press the Marker 1 2 3 4 5 6 submenu key and then select the desired marker by using 
the touch screen marker buttons. The selected marker is underlined on the Marker 
submenu key. 

2. Press the On Off submenu key so that On is underlined. The selected marker is 
displayed in red and ready to be moved.

3. Use the rotary knob to place the marker on the desired frequency.

4. Repeat Step 1 through Step 3 to activate and move additional markers.

Selecting, Activating, and Placing a Delta Marker:

1. Press the Marker 1 2 3 4 5 6 submenu key and select the desired delta marker. 
The selected marker is underlined.

2. Press the Delta On Off submenu key so that On is underlined. The selected marker is 
displayed in red and ready to be moved.

3. Use the rotary knob to place the delta marker on the desired frequency.

4. Repeat Step 1 through Step 3 to activate and move additional markers.

Viewing Marker Data in a Table Format

1. Press the More submenu key.

2. Press the Marker Table On Off submenu key so that On is underlined. All marker and 
delta marker data are displayed in a table under the measurement graph.

Figure 3-7. Marker Table
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Select a Smart Measurement Type

In Spectrum Analyzer mode, press Shift then Measure (4) and select a smart one-button 
measurement using the submenu keys. The smart one-button measurements are built-in for 
field strength, occupied bandwidth, channel power, adjacent channel power ratio, and carrier 
to interference ratio (C/I) tests. In addition, AM/FM demodulation is available to aid in the 
identification of interfering signals. Refer to the Spectrum Analyzer Measurement Guide 
listed in Appendix A, “Measurement Guides” for additional information. 

Figure 3-8. Spectrum Analyzer Measure Menu with Smart Measurements
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3-6 NBFM Analyzer
Set the instrument to NBFM Analyzer mode as described in Section 3-2 “Measurement Mode 
Selection” on page 3-1.

Set the Receiver (Rx) Frequency 

1. Press the Freq main menu key. 

2. Press the Rx Freq submenu key.

3. Enter the desired center frequency using the keypad, the arrow keys, or the rotary knob. 
When entering a frequency using the keypad, the submenu key labels change to GHz, 
MHz, kHz, and Hz. Press the appropriate unit key. Pressing the Enter key has the same 
affect as pressing the MHz submenu key. The center frequency and span is shown at the 
bottom of the spectrum display. Press the Span submenu key to adjust the 
measurement span. 

4. Press Setup main key. Use the submenu keys to select the Tone Type.

5. Under the Amplitude main menu, the Auto Rx Range default will adjust the reference 
level to display the received signal. To adjust the settings, press Adjust Rx Range then 
set the Ref Level and Scale. 

Set the Signal Source Transmit (Tx) Frequency 

The LMR Master contains a signal generator and test patterns for analog FM land mobile 
radios. The maximum output power is 1.0 milliwatt.

1. Press the Freq main menu key. 

2. Press the Tx Freq submenu key.

3. Enter the desired frequency using the keypad, the arrow keys, or the rotary knob. When 
entering a frequency using the keypad, the submenu key labels change to GHz, MHz, 
kHz, and Hz. Press the appropriate unit key. Pressing the Enter key has the same affect 
as pressing the MHz submenu key. 

4. Press Setup main key and use the Tx pattern submenu key to set the transmit pattern. 
Press Enter after selecting a pattern. Based on the pattern selected, set the 
AM Percentage or the FM Deviation and Tone Deviation (under the More menu).

Note
The following Quick Start instructions apply to the NBFM mode. For detailed 
measurement instructions, refer to the Land Mobile Measurement Guide 
P/N 10580-00243, listed in Appendix A.

Caution
The maximum input power without damage is 2 Watts (+33 dBm) to the RF In 
50 Ohm connector. To prevent damage, use a coupler or attenuator to reduce the 
input power to below this level when measuring high output power devices.

Note
Bind the transmit frequency to receive frequency using the Rx/Tx Coupling and 
Coupling offset submenus under the Frequency menu.
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5. Under the Amplitude main menu, set the signal generator output power using the 
Tx Output Lvl submenu. 

6. Press the Turn Sig-Gen ON main menu key to turn on the internal signal generator.
The menu button display Turn Sig-Gen OFF when the generator is running. 

Rx and Tx Power Offset 

To obtain accurate results, compensate for any external attenuation or gain by using the 
Rx Power Offset or Tx Power offset submenus under the Amplitude main menu key. In power 
offset mode, the compensation factor is in dB. 

Press the Rx Power Offset or Tx Power Offset submenu key and use the keypad, the arrow 
keys, or the rotary knob to enter the desired offset value. When using the rotary knob, the 
value changes in increments of 0.1 dB. Using the Left/Right arrow keys changes the value in 
10% increments of the value shown on the Scale submenu key. The power offsets for Tx and 
Rx are displayed in the instrument settings summary column on the left side of the 
measurement display.

Select the Measurement Types

NBFM Analyzer Measurement

1. Press the Measurement main menu key, then press the NBFM Analyzer submenu key. 
Press Graph Type to set the displayed graph types (Figure 3-11). 

2. Select the graph to change with the Active Graph submenu key or the touchscreen. 
Change the graph with the Graph Type submenu key. 

Figure 3-9. NBFM Analyzer Measurements (Active Graph has the Red Outline) 
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NBFM Coverage Measurement

1. Press the Measurement main menu key, then press the NBFM Coverage submenu key 
twice (Figure 3-13).

2. Refer to the Land Mobile Radio Measurement Guide listed in Appendix A for details on 
creating a map and coverage mapping.

NBFM Quieting and NBFM SINAD Measurements

Refer to the Land Mobile Radio Measurement Guide listed in Appendix A for details on radio 
sensitivity testing using the 12 dB SINAD and 20 dB Quieting methods. 

Figure 3-10. NBFM Coverage Measurements 
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3-7 P25/P25p2, NXDN™, DMR 2, ITC-R PTC, or TETRA 
Signal Analyzer

Set the instrument to P25/P25p2 Analyzer, NXDN Analyzer, DMR 2 Analyzer, 
PTC Analyzer, or TETRA Analyzer mode as described in Section 3-2 “Measurement Mode 
Selection” on page 3-1.

Set the Receiver (Rx) Frequency 

1. Press the Freq main menu key. 

2. Press the Rx Freq submenu key.

3. Enter the desired center frequency using the keypad, the arrow keys, or the rotary knob. 
When entering a frequency using the keypad, the submenu key labels change to GHz, 
MHz, kHz, and Hz. Press the appropriate unit key. Pressing the Enter key has the same 
affect as pressing the MHz submenu key. The center frequency and span is shown at the 
bottom of the spectrum display. Press the Span submenu key to adjust the 
measurement span. 

4. Press Setup main key. Use the submenu keys to select the Mod Type (Mod Bandwidth in 
NXDN) and Rx pattern (not applicable to PTC mode).

5. Under the Amplitude main menu, the Auto Rx Range default will adjust the reference 
level to display the received signal. To adjust the settings, press Adjust Rx Range then 
set the Ref Level and Scale. 

Set the Signal Source Transmit (Tx) Frequency 

The LMR Master contains a signal generator and test patterns for LMR antenna and receive 
system verification. The maximum output power is +0 dBm (1.0 mW).

1. Press the Freq main menu key. 

2. Press the Tx Freq submenu key.

3. Enter the desired frequency using the keypad, the arrow keys, or the rotary knob. When 
entering a frequency using the keypad, the submenu key labels change to GHz, MHz, 
kHz, and Hz. Press the appropriate unit key. Pressing the Enter key has the same affect 
as pressing the MHz submenu key. 

4. Press Setup main key and use the Tx pattern submenu key to set the transmit pattern. 
Press Enter after selecting a pattern. PTC Only: Set the Symbol Rate.

Note
The following Quick Start instructions apply to the Land Mobile Radio modes. For 
detailed measurement instructions, refer to the Land Mobile Measurement Guide 
P/N 10580-00243, listed in Appendix A.

Note Generation of TETRA signals is not currently supported by the LMR Master.

Note
If desired, the transmit frequency can be bound to the receive frequency using the 
Rx/Tx Coupling and Coupling offset submenus under the Frequency menu.
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5. Under the Amplitude main menu, set the signal generator output power using the 
Tx Output Lvl submenu. 

6. Press the Turn Sig-Gen ON main menu key to turn on the internal signal generator.
The menu button display Turn Sig-Gen OFF when the generator is running. 

Rx and Tx Power Offset 

To obtain accurate results, compensate for any external attenuation or gain by using the 
Rx Power Offset or Tx Power offset submenus under the Amplitude main menu key. In power 
offset mode, the compensation factor is in dB. (External attenuation can be created by using 
an external cable or an external high power attenuator.)

Press the Rx Power Offset or Tx Power Offset submenu key and use the keypad, the arrow 
keys, or the rotary knob to enter the desired offset value. When using the rotary knob, the 
value changes in increments of 0.1 dB. Using the Left/Right arrow keys changes the value in 
10 % increments of the value shown on the Scale submenu key. When using the Up/Down 
arrow keys, the value changes in the increment shown on the Scale submenu key. When 
using the keypad, enter the new value then press Enter or the dB submenu key to set the 
value. The power offsets for Tx and Rx are displayed in the instrument settings summary 
column on the left side of the measurement display.

Select the Measurement Types

Analyzer Measurements

1. Press the Measurement main menu key, then press the P25 Analyzer, P25p2 Analyzer, 
NXDN Analyzer, DMR 2 Analyzer, PTC Analyzer, or the TETRA Analyzer submenu key. 
Press Graph Type to set the displayed graph types (Figure 3-11). 
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2. Select the graph to change with the Active Graph submenu key or the touchscreen. 
Change the graph with the Graph Type submenu key. 

Figure 3-11. Analyzer Measurements (Active Graph has the Red Outline) 



3-7 P25/P25p2, NXDN™, DMR 2, ITC-R PTC, or TETRA Signal Analyzer Quick Start Guide 

3-20 PN: 10580-00318  Rev. K S412E UG

Control Channel Measurement  (not available in PTC or TETRA modes)

1. Press the Setup main menu and set the Rx Pattern to Ctrl Channel or Voice. 

2. Press the Measurement main menu key, then press the P25 Control, P25p2 Control, 
NXDN Control or DMR 2 Control submenu key twice.

3. To save control channel data for additional analysis, insert a formatted USB flash drive 
into the LMR Master and turn Log Data On. 

4. Set the Hex Trigger, Sweep and Set Trigger Value (Figure 3-12). The Hex Trigger menu 
and Hex Trigger Value menu are used to find a specific opcode in the Control Channel 
data. To set the hex trigger value, press the Set Trigger Value menu. An on screen 
keyboard will display and with the numbers 0 to 9 and the letters A to F. Enter the two 
character hex value to search for. After entering the value, press Enter to set the trigger 
value. Press Esc to cancel entry or changing the current hex value. 

Setting Hex Trigger to On will set the Sweep function to Hold when the hex trigger value 
is found in the first octet of a packet. The octet row with the found trigger value will be 
displayed in the middle of the table. If Log Data is set to On, all of the data on the screen 
is saved and Log Data is set to Off. When Sweep is set back to Run, the unit will 
continue to collect data and stop on the next instance of the hex trigger value. To 
continue to capture data to the USB flash drive, set Log Data back to On before setting 
Sweep to Run mode. 

Figure 3-12. Control Channel Measurement 

Note
This measurement is captured on an external USB flash drive. The captured data 
file can not be recalled and displayed on the instrument screen. 



Quick Start Guide 3-7 P25/P25p2, NXDN™, DMR 2, ITC-R PTC, or TETRA Signal Analyzer

S412E UG PN: 10580-00318  Rev. K 3-21

Coverage Measurements

1. Press the Measurement main menu key, then press the P25 Coverage, P25p2 Coverage, 
NXDN Coverage, DMR 2 Coverage, PTC Coverage, or TETRA Coverage submenu key 
twice (Figure 3-13).

2. Refer to the Land Mobile Radio Measurement Guide listed in Appendix A for details on 
creating a map and coverage mapping.

Figure 3-13. Coverage Measurements 
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Bit Capture Measurement (not available in PTC or TETRA modes)

1. Press the Setup main menu and set the Rx Pattern to Voice.

2. Press the Measurement main menu key, then press the P25 Bit Capture, 
P25p2 Bit Capture, NXDN Bit Capture or DMR 2 Bit Capture submenu key. 

3. To save bit capture data for additional analysis, insert a formatted USB flash drive into 
the LMR Master and turn Log Data On. (Figure 3-14). 

IQ Capture Measurement

1. Insert a formatted USB flash drive in the USB port of the LMR Master.

2. Press the Measurement main menu key, then press the P25 IQ Capture, P25p2 IQ 
Capture, NXDN IQ Capture, DMR 2 IQ Capture, PTC IQ Capture, or TETRA IQ Capture 
submenu key.

3. After a few second the LMR Master will display the message “IQ Capture Complete”.

4. The IQ data is stored on the USB flash drive under the /usr folder in a date stamped 
folder. The file will be IQ_CAPTUREyearmonthdaytime.p25 (or .p252, .nxdn, .dmr2, 
.ptc, or .tetra).

Figure 3-14. Bit Capture Measurement 

Note
These measurements are captured on an external USB flash device. The captured 
data file can not be recalled and displayed on the instrument screen. 
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3-8 Saving Measurements 
The LMR Master can save files in the following formats based on measurement mode and 
installed options:

filename.spa for SPA measurement

filename.mna for VNA and VVM measurements

filename.s2p S2P (SnP) for VNA S-parameter measurements

filename.hipm for High Accuracy Power Meter measurements

filename.pm for Power Meter measurements.

filename.cwsg for CWSG measurements.

filename.afp for AM/FM/PM measurements

filename.ia for Interference Analysis measurements

filename.cs for Channel Scanner measurements

filename.wmxd for WiMAX

filename.wmxe for Mobile WiMAX

filename.lte for LTE measurements

filename.nbfm for NBFM measurements

filename.p25 for P25 measurements

filename.p252 for P25p2 measurements

filename.nxdn for NXDN measurements

filename.dmr2 for DMR 2 measurements

filename.ptc for PTC measurements

filename.tetra for TETRA measurements

filename.jpg for JPEG images

filename.stp for Setup files

filename.lim for Limit lines

Procedure for Saving Files:

1. Press Shift then File (7).

2. Press Save.

3. Press Change Save Location and set the current location to be the USB flash drive or 
internal memory, and then press Set Location.

4. Press Change Type (Setup/JPG/…) and select the desired file type from the Select File 
Type list box and press Enter.

5. Enter the filename by using the keyboard and then press Enter.

Refer to Chapter 4, “File Management” for additional details about working with files.

Note The LMR Master is not fully supported in Master Software Tools. 



3-9 External Power On Quick Start Guide 

3-24 PN: 10580-00318  Rev. K S412E UG

3-9 External Power On  
This feature allows the LMR Master to restart when external DC power is applied. 

This source of external power is applied to the power connector as described in “External 
Power” on page 2-10. This connector is shown as item 8 in Figure 2-8 on page 2-9. When this 
feature is enabled from the Power–On menu, the LMR Master (when Off) automatically 
restarts when external DC power is applied. Refer to “Power–On Menu” on page 5-10.
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Chapter 4 — File Management

4-1 Introduction
This chapter describes the file management features of the LMR Master and describe the 
File menu. The submenus under this menu allow you to save, recall, copy, and delete files in 
internal memory or an external USB flash drive.

4-2 File Types 
Filename extensions that are used in the LMR Master:

*.spa for SPA measurement

*.mna for VNA and VVM measurements

*.s2p S2P (SnP) for VNA S-parameter measurements

*.hipm for High Accuracy Power Meter measurements

*.pm for Power Meter measurements.

*.cwsg for CWSG measurements.

*.afp for AM/FM/PM measurements

*.ia for Interference Analysis measurements

*.cs for Channel Scanner measurements

*.wmxd for WiMAX

*.wmxe for Mobile WiMAX

*.lte for LTE measurements

*.nbfm for NBFM measurements

*.p25 for P25 measurements

*.p252 for P25p2 measurements

*.nxdn for NXDN measurements

*.dmr2 for DMR 2 measurements

*.ptc for PTC measurements

*.tetra for TETRA measurements

*.jpg for JPEG images

*.stp for Setup files

*.lim for Limit lines

Note
S2P is a standard ASCII text file format that is used for scattering parameters from 
a 2-Port measurement. This is a subset of SnP (where n equals the number of 
ports).
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4-3 Managing Files 
Press the Shift key then the File (7) key on the numeric keypad to list the File menu.

Save Files

Set the Save Location 

Press Save then the Change Save Location submenu key and select the location to save files. 
Files can be saved to the internal memory or to an external USB flash drive. New folders can 
be created at either location. Press Refresh Directories to update the location tree. Press the 
Set Location key to set the save location.

Save Measurement As

The Save Measurement As key is used to quickly save measurements with a specific file 
name. The LMR Master saves the measurement with the latest file name that was used to 
save a measurement and with a number that is automatically incremented and appended to 
the end of the file name. For instance, if the last measurement was saved with the name 
System Return Loss, Save Measurement As saves the next measurement as System Return 
Loss_#1, System Return Loss_#2 etc. The file name used can be changed using the Save 
dialog box (Figure 4-1).

Save a Measurement

Press the Save Measurement key and enter the name for the measurement file. 

Save a Setup

Press the Save submenu key, type a name for the setup file, confirm that the file type is Setup 
using the Change Type key or the touchscreen, and then press Enter to save. 

Create a Menu Shortcut for a Setup File

Press the Recall submenu key to display saved setup files. Locate the setup file to shortcut 
and then using the touch screen press and hold on the file name for a few seconds. Select a 
location in the shortcut grid to save the setup file.

Save a Measurement Screen as JPEG 

Press the Save submenu key, type a name for the JPEG file, confirm that the file type is Jpeg, 
and press Enter to save.

Note
When navigating through the File menu, pressing the Esc key returns to the 
previous menu.
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Save Dialog Box

The save dialog box (Figure 4-1) is used to store files on the internal memory or an external 
flash drive. The file type, file name, and save location are set starting with this display. Refer 
to “Save Menu” on page 4-9 and “Save Location Menu” on page 4-10 for details. 

Quick Name Keys 

Quick Name keys (located below the keyboard in Figure 4-1) allow you to enter quick names 
for frequently used parts of file measurement names. To edit the keys, press the Shift key, 
then the File (7) key. Press Save then the Change Quick Name key, and select one of the 
Quick Names for editing. Press Enter and enter the new name for the key. Press Enter again, 
and the new name is displayed on the Quick Name key. 

When entering filenames, use the quick name keys in any order in combination with the 
keyboard to create measurement filenames.

Note The Save Dialog Box will vary based on current measurement mode.

Figure 4-1. Save Dialog Box
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Recall Files

The recall menu enables you to view all of the Measurement and Setup files in the internal 
memory and in an external USB flash drive.

You can sort the recall menu by name, date, or type. You can also choose to view only 
measurement files or setup files by pressing File Type on the Recall dialog box and selecting 
the file type that you want to view.

Recall a Measurement

From the File menu, press the Recall Measurement submenu key, select the measurement 
with the touchscreen, rotary knob, or the Up/Down arrow keys, and then press Enter. 

Recall a Setup

Press the Recall submenu key. Confirm that the file type is Setup or All. Select the setup file 
(.stp) with the touchscreen, rotary knob, or the Up/Down arrow keys, and then press Enter.

Recall Dialog Box 

The Recall dialog box (Figure 4-2) opens previously saved measurements and setups. Refer 
to the “Recall Menu” on page 4-12 for additional information. 

Figure 4-2. Recall Dialog Box
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Copy Files

The steps below describe copying a file from internal memory to an external flash drive. 
Select the files to copy in the top window and the location for the files (to be copied) in the 
bottom window (Figure 4-3). Refer to the “Copy Menu” on page 4-13 for additional 
information.

1. Insert a USB flash drive into either USB Type A port of the LMR Master. 

2. From the File main menu, press the Copy submenu key. The Copy menu and Copy 
dialog box are displayed.

3. Select the files that are to be copied. To select multiple files, highlight the first file, then 
press the Select or De-Select key to keep the file selected. The selected file is outlined in 
blue. Repeat with all the files that are to be copied. To display files in a folder, select the 
folder and press the Enter key.

4. Press the Scroll key and highlight the USB flash drive in the lower window using the 
touch screen or the Up/Down arrow keys. The Scroll submenu key toggles between 
source and destination, Src (top window) and Dst (bottom window).

5. Press the Copy key to copy the files to the flash drive.

Figure 4-3. Copy Dialog Box
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Delete Files 

Press the Delete submenu key. Highlight the file to be deleted with the touchscreen or the 
Up/Down arrow keys. Press the Select or De-Select key. Selected files are outlined in blue. 
Press the Delete key and then press Enter to delete the selected file.

Delete Dialog Box

Press the Delete submenu key to open the Delete dialog box (Figure 4-4). The menus allow 
sorting by file type, name, and saved date. Refer to the “Delete Menu” on page 4-14 for 
additional information. 

Figure 4-4. Delete Dialog Box
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4-4 File Menu Overview
Open this menu by pressing the Shift key, then the File (7) key. 

Figure 4-5. File Menu
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4-5 File Menu 
Key Sequence: File

Save Measurement As: Press this submenu key to save the current setup 
with a user defined filename. The default filename is changed using the Save 
menu. To change the default file name, type in a new file with the touch 
screen keyboard and press Enter. After a few seconds, the screen returns to 
File menu. Press the Save Measurement As key again and the new file 
name is used. 

Save Measurement: Press this submenu key to display the “Save Menu” 
on page 4-9 and the touch screen keyboard. Measurements can be saved to 
internal memory or to a USB flash drive. The saved measurement can be 
named by using the touch screen keyboard. By default, measurements are 
saved to internal memory in a directory named /user. The save destination is 
set with the “Save Location Menu” on page 4-10.

Save: Press this submenu key to display the “Save Menu” on page 4-9 and 
the touch screen keyboard. Measurements can be saved to internal memory 
or to a USB flash drive. The saved setup, measurement, or JPEG file can be 
named by using the touch screen keyboard. By default, measurements are 
saved to internal memory in a directory named /user. The save destination is 
set with the “Save Location Menu” on page 4-10.

Save on Event: Press this submenu key to display the “Save On Event 
Menu” on page 4-11. This submenu key is displayed only in LMR Analyzer 
modes.

Recall Measurement: Press this submenu key to display the “Recall 
Menu” on page 4-12. This menu is for recalling measurements from internal 
memory or from a USB flash drive.

Recall: Press this submenu key to display the “Recall Menu” on page 4-12. 
This menu is for recalling measurement or setup data from internal memory 
or from a USB flash drive.

Copy: Press this submenu key to display the “Copy Menu” on page 4-13. 
The Copy menu is for copying files or folders from internal memory or a USB 
flash drive.

Delete: Press this submenu key to display the “Delete Menu” on page 4-14 
and a selection box that shows the setup and measurement names and the 
type, date, and time that the information was saved. Use the rotary knob or 
the Up/Down arrow keys to highlight the file that is to be deleted and press 
the Delete submenu key, then press Enter. Press the Esc key to cancel the 
operation. Note that deleted files cannot be recovered.

Figure 4-6. File Menu
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Save Menu 

The top keys in the Save menu display the available file-type save options based on the 
current measurement mode.

Key Sequence: File > Save 

Change Quick Name: Press this submenu key to change the Quick Names 
that are displayed at the bottom of the touch screen keyboard (Figure 4-1). 
Select the Quick Name to edit and press Enter. Type the new Quick Name 
and press Enter again. The new Quick Name is displayed on the 
corresponding Quick Name button below the keyboard.

Change Save Location: Press this submenu key to open the 
“Save Location Menu”. 

Change Type Setup/JPG/... Press this submenu key in VNA and VVM 
modes to select among the various file types available for setup and 
measurement data. This submenu key also opens the File Type menu with a 
submenu key to select Full screen or Graph Only images for JPEG file types. 
This submenu key is not displayed in Spectrum Analyzer or Interference 
Analyzer modes

Figure 4-7. Save Menu
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Save Location Menu 

This menu and dialog box are used to create folders and to select the location where the 
LMR Master saves the current file. Select folders or drives with the Up/Down keys, the rotary 
knob, or the touch screen. 

Key Sequence: File > Save > Change Save Location 

Note
Only folders (not files) are visible in the Save Location dialog box. To view files, use 
the “Recall Menu” on page 4-12.

Sort By
Name Date type: Press this submenu key to sort the folders by Name, 
Type, or Date. 

Sort Order
Asc Desc: Press this submenu key to display the folder names in 
ascending or descending order.

Create Folder: Press this submenu key to create a new folder in the 
highlighted location or folder. Name the new folder in the create directory 
dialog box.

Set Location: Press this submenu key to set the current location for saving 
files and then return to the “Save Menu” on page 4-9.

Refresh Directories: Press this submenu key to update the display.

Figure 4-8. Save Location Menu

Figure 4-9. Select Save Location Dialog Box
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Save On Event Menu 

In all Spectrum Analyzer, Interference Analyzer, and LMR Analyzer modes, this menu is 
used to auto save measurements to internal memory after a set events occur.

Key Sequence: File > Save On Event 

...Crossing Limit
On Off: Toggling this submenu key to On sets the LMR Master to save 
the measurement to internal memory when the measurement has crossed a 
defined limit line that has been created with the Limit menu.

...Sweep Complete
On Off: Toggling this submenu key to On sets the LMR Master to save 
the measurement to internal memory after the current sweep is complete. If 
Save Then Stop is toggled Off, then a measurement is saved after every 
sweep.

Save Then Stop
On Off: Toggling this key to On sets the LMR Master to stop the sweep 
after a measurement is saved. With this key Off and Sweep Complete On, a 
measurement is saved after every sweep.

Clear All: Press this key to turn Off all three save-on-event keys:

Crossing Limit

Sweep Complete

Save Then Stop 

Back: Press this key to return to the “File Menu” on page 4-8.

Figure 4-10. Save On Event Menu (Spectrum and Interference Analyzer Modes)

Squelch Crossing
On Off: Toggling this submenu key to On sets the LMR Master to save 
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Back: Press this key to return to the “File Menu” on page 4-8.

Figure 4-11. Save On Event Menu (LMR Analyzer Modes)
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Recall Menu 

This menu and its dialog box are used to select the location from which the LMR Master 
recalls a file. Select folders or drives with the Up/Down arrow keys, the rotary knob, or the 
touch screen. 

Key Sequence: File > Recall 

Sort By
Name Date Type: Press this submenu key to sort files and folders by 
the file name, by the type of file, or by the date that the file or folder was 
saved.

Sort Order
Asc Desc: Displays the folder or file in ascending or descending order 
based on the selection in the Sort By key.

File Type: Press this submenu key to select the type of file to be viewed. 
The file type can be changed with the Up/Down arrow keys, the rotary 
knob, or the touch screen. Press Enter to make the selection. Refer to 
Section 4-2 “File Types” for file type descriptions.

Refresh Directories: Press this key to update the display.

Figure 4-12. Recall Menu
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Copy Menu 

This menu and dialog box are used to copy folders and files. Select folders or files with the 
Up/Down arrow keys, the rotary knob, or the touch screen. Figure 4-3 on page 4-5 shows the 
Copy dialog box with two JPEG images and one folder (including the folder contents) selected 
and ready to be copied to the USB flash drive. Highlight a folder and press Enter to view the 
contents.

Key Sequence: File > Copy 

Sort By
Name Type Date: Press this submenu key to sort file and folder lists 
by name, by type of file, or by the date that a file was saved.

Sort Order
Asc Desc: Press this submenu key to display the folders or files in 
ascending or descending order based on the selection in the Sort By key.

File Type: Press this submenu key to select the type of files to view for 
copying. The file type can be changed with the Up/Down arrow keys, the 
rotary knob, or the touch screen. Press Enter to make the selection. Refer 
to Section 4-2 “File Types” for file type descriptions.

Refresh Directories: Press this submenu key to update the display. 

Scroll
Src Dst: Press this submenu key to use the scroll function in the Source 
Folder (Src or top panel) or in the Destination Folder (Dst or bottom panel). 
Refer to Figure 4-3.

Select or De-Select: Press this submenu key to select or deselect the files 
or folders to be copied. When selected, a file or folder is outlined in blue. 
Refer to Figure 4-3.

Copy: Press this submenu key to copy the files or folders that are selected 
in the top window to the destination that is selected in the bottom window. A 
dialog box indicates when the copying is complete. If a file with the same 
name exists in the destination folder, then a warning box is displayed to 
allow file overwrite or cancel.

Figure 4-13. Copy Menu
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Delete Menu

This menu and dialog box are used to delete folders and files. Select folders or files with the 
Up/Down arrow keys, the rotary knob, or the touch screen.

Key Sequence: File > Delete 

Sort By
Name Date Type: Press this submenu key to sort files and folders 
by name, by the type of file, or by the date that the file or folder was saved.

Sort Order
Asc Desc: Press this submenu key to display the folders or files in 
ascending or descending order based on the selection in the Sort By key.

File Type: Press this submenu key to select the type of file to be deleted. 
The file type can be changed with the Up/Down arrow keys, the rotary 
knob, or the touch screen. Press Enter to make the selection. Refer to 
Section 4-2 “File Types” for file type descriptions.

Select or De-Select: Press this submenu key to select or deselect the files 
or folders to be deleted. When selected, a file or folder is outlined in blue.

Delete: Press this submenu key to open the Delete dialog box. Press 
Enter to delete the selected item, or press Esc to Cancel. 

Refresh Directories: Press this submenu key to update the display.

Figure 4-14. Delete Menu
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Chapter 5 — System Operations 

5-1 Introduction
This chapter describes the LMR Master system operations.

• “System Menu Group Overview” on page 5-2

• “System Menu” on page 5-4

• “Preset Menu” on page 5-13

• “Self Test” on page 5-13

• “Updating the LMR Master Firmware” on page 5-14

The other menus (Sweep, Measure, Trace, and Limit) are described in the Measurement 
Guides that are listed in Appendix A.
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5-2 System Menu Group Overview 
To access the functions under the System menu, press the Shift key, then the System (8) key. 
Figure 5-1 and Figure 5-2 show the menu group that is accessible from the System menu. 
Menu maps typically display all possible submenu keys, although some keys are displayed on 
the instruments only under special circumstances (refer to the menu descriptions on the 
following pages).

Note that the menus that are indicated by numbered circles are shown in Figure 5-2.

System Menu Map 1  

Figure 5-1. System Menu Map – Part 1

GPS

Back

GPS

On               Off

GPS Voltage

3.3 V             5 V

GPS Info

Reset

System

System

Options

Application

Options

GPS

Status

Self

Test

Application
Self
Test

Calibrate
Touch
Screen

1Reset

System Options

Date
&

Time

Language

Name

Volume

More

Display

2 Back

Display Settings

Brightness

Default Colors

Black on White

Night Vision

High Contrast

Display Blank

Color on White



System Operations 5-2 System Menu Group Overview

S412E UG PN: 10580-00318  Rev. K 5-3

System Menu Map 2 

To access the functions under the System menu, press the Shift key, then the System (8) key. 

Figure 5-2. System Menu Map – Part 2
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5-3 System Menu 
Key Sequence: Shift, System (8) 

Status: Press this submenu key to display the current system status, 
including the operating system and firmware versions, temperatures and 
other details such as current battery information. Press Esc or Enter to 
return to normal operation.

Self Test: Press this submenu key to initiate a series of diagnostic tests that 
check the components of the instrument. A display lists the individual tests 
with a pass or fail indication. Press Esc or Enter to return to normal 
operation.

Application Self Test: Press this submenu key to initiate a series of 
diagnostic tests related to the performance of the instrument for specific 
applications. A display lists the individual tests with a pass or fail indication. 
Press Esc or Enter to return to normal operation.

GPS: Opens the “GPS Menu” on page 8-3. This submenu key is displayed 
only when the GPS (Option 31) is installed.

Calibrate Touch Screen: Press this submenu key to start the touch screen 
calibration. Run the calibration procedure when the instrument is not 
responding to your screen taps as expected.

Application Options: Press this submenu key to open a menu to select 
application options. This varies depending upon the measurement 
(application) mode. Refer to “Application Options Menu” on page 5-5.

System Options: Press this submenu key to open the “System Options 
Menu” on page 5-7.

Figure 5-3. System Menu
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5-4 Application Options Menu
Key Sequence: Shift, System (8) > Application Options

The display of this menu varies based on the current measurement mode. In addition to the 
following information, refer to the appropriate Measurement Guide listed in Appendix A.

VNA Mode   

Units
m ft: Press this submenu key to toggle the units setting to metric (meters, 
or m) or to U.S. (feet, or ft). Press Enter to accept the changes, or press the 
Esc key to return to normal operation without changing the setting.

Trace Label
On Off: Press this submenu key to toggle the trace labels On or Off.

Meas Gain Range: Press this submenu key to open the Mode Menu.   
Select Auto or Fixed. 

Auto: Press this submenu key to set the Measurement Gain Range 
Mode to Auto. In this mode, the instrument adjusts the gain 
automatically to provide the best overall system performance 
(dynamic range and high level noise). 

Fixed: Press this submenu key to set the Measurement Gain Range 
Mode to Fixed. In this mode, the gain of the instrument is always set to 
the low gain setting. For most applications, Auto mode is 
recommended. For certain types of filter measurements (mostly in the 
range less than 500 MHz), the instrument may toggle between low 
gain and high gain modes as the signal level rises from the noise to 
the pass band of the filter, resulting in extra ripple. Setting the Gain 
Range to fixed may address that problem.

Meas Menu
Field VNA: Press this submenu key to toggle between Field (a simplified 
subset of the standard VNA menu structure) and VNA (standard menu 
structure.

Back: Press this submenu key to return to the “System Menu” on page 5-4.

Figure 5-4. Application Options Menu (VNA Mode)
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SPA Mode 

Key Sequence: Shift, System (8) > Application Options 

Impedance
50 Ohm 75 Ohm Other: Press this submenu key to toggle the 
impedance setting to 50 ohm, 75 ohm, or Other impedance value. 
Selecting 75 ohm selects the 7.5 dB loss of the Anritsu 12N50-75B 
adapter. For other adapters, select Other and enter the appropriate loss.

Bias Tee (Option 10 required): Opens the Bias Tee submenu. When 
turned on, the Bias Tee voltage and current is shown in the lower left 
corner of the display. 

Bias Tee: Toggles On and Off the variable power supply.

Bias Tee Voltage: Use this submenu to set the power supply 
voltage. 

Current: Toggle the current between Low and High.

Back: Press this submenu key to return to the Application Options 
Menu.

Back: Press this submenu key to return to the “System Menu” 
on page 5-4.

Figure 5-5. Application Options Menu (SPA Mode)
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5-5 System Options Menu   

System Options Menu  

Key Sequence: Shift > System (8) > System Options 

Date & Time: Press this submenu key to display a dialog box for setting the 
current date and time. Use the submenu keys or the Left/Right arrow keys to 
select the field to be modified. Use the keypad, the Up/Down arrow keys, or 
the rotary knob to select the date and time. Press Enter to accept the 
changes, or press the Esc key to return to normal operation without changing 
anything.

Language: Press this submenu key to open a list box and select a built-in 
language for the VNA Master displays. The languages that are currently 
available are: English, French, German, Spanish, Japanese, Chinese, 
Korean, Italian, and Russian. In addition, a custom language may be selected 
if it has been defined by using Master Software Tools and loaded into the 
VNA Master. One custom language may be loaded into the instrument via 
Master Software Tools. If a mode does not have language translations 
available, then English is the default language. Press Enter to accept the 
change, or press the Esc key to return to normal operation without changes.

In addition, any existing language (except English) may be edited for a better 
local translation.

Caution: A reset will overwrite any custom settings within the 
VNA Master and will require that you reload the custom language files 
via Master Software Tools.

Display: The Display submenu key opens the “Display Settings Menu” 
on page 5-11 allowing brightness control and the selection of different display 
attributes.

Name: Press this submenu key to open a dialog box to name the instrument. 
The VNA Master can be named by using the text entry controls as described 
in section “Text Entry” on page 2-15. Press Enter to save the name.

Volume: Press this submenu key to set the speaker volume. The current 
volume setting is displayed on the screen. Use the keypad, the Up/Down 
arrow keys, or the rotary knob to change the volume, and press the Enter key 
to accept the change.

Reset: Press this submenu key to open the “Reset Menu” on page 5-12.

More: Press this submenu key to open the “System Options 2/2 Menu” 
on page 5-8.

Figure 5-6. System Options Menu
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System Options 2/2 Menu    

Key Sequence: Shift > System (8) > System Options > More 

Share CF & Pwr Offset
All Modes Not Shared: Press this submenu key to toggle the setting to 
All Modes or to Not Shared. Select All Modes to have the current center 
frequency setting and power offset setting carried over when changing 
measurement modes. This function is not applicable to measurements that do 
not have a center frequency or power offset setting or to measurements in 
which the current center frequency or power offset setting is outside the range 
of the new measurement.

Set Remote Access Password: Press this submenu key to open the 
Password text box (Figure 5-8) and Text Entry menu. Type in the desired 
password. Upper case and lower case letters and the symbols - _ + . are 
the allowed password characters. Press Enter to save or Esc to cancel.

Power–On: Press this submenu key to open the “Power–On Menu” 
on page 5-10.

Back: Press this submenu key to return to the “System Options Menu” 
on page 5-7.

Figure 5-7. System Options Menu 2/2) 
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Remote Access Password           

This function is valid only with Master Software Tools (MST) v2.21.1 or later. After setting 
the password, reboot the instrument (normal power OFF then ON) to provide remote access 
security. Only one user then has remote access at any one time. 

The password is first set into the instrument, then used in MST. When prompted in MST, 
enter the password into the password text box. The password text box shown in Figure 5-8 
may differ from the text box that is displayed on your instrument. 

The password can be removed or reset by a Master Reset, by a Factory Default reset, or by a 
firmware update (which includes a restart).

Warning Do not use SCPI commands with this feature.

Figure 5-8. Remote Access Password Text Box
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Power–On Menu      

Key Sequence: Shift > System (8) > System Options > More > Power–On 

Power Switch: Press this submenu key to set the VNA Master for normal 
use of the On/Off button on the instrument face.

When DC Applied: Press this submenu key to set the VNA Master to 
automatically restart when DC power is applied to the External Power 
connector (item 8 in Figure 2-8 on page 2-9). Refer to “External Power On” 
on page 3-24.

Back: Press this submenu key to return to the “System Options 2/2 Menu” 
on page 5-8.

Figure 5-9. Power–On Menu 
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5-6 Display Settings Menu     
Key Sequence: Shift, System (8) > System Options > Display 

Brightness: Press this submenu key to adjust the brightness of the display 
to optimize viewing under a wide variety of lighting conditions. Use the 
keypad, the Up/Down arrow keys or the rotary knob to select a brightness 
level from 1 to 9, with 9 being the brightest. Press Enter to accept the 
change.

Display Blank: Opens a note box. Press Enter to turn off the display, or  
press Esc to abort. When the display is off, turn on the display with three 
rapid key presses of any key except the power key (or turn instrument power 
Off and On).

Default Colors: Press this submenu key to set the display colors to their 
factory default condition. Use for normal viewing.

Black on White: Press this submenu key to set the display colors to black 
and white. Use for printing and viewing in broad daylight conditions.

Night Vision: Press this submenu key to set the display to a red-tinted 
color, which is optimized for night-time viewing.

High Contrast: Press this submenu key to increase the contrast of the 
default display colors. Used for other challenging viewing conditions.

Color on White: Press this submenu key to invert the black background 
color to produce a white background and black graticule lines with colored 
traces. Use for viewing in broad daylight conditions and for color printing.

Back: Press this submenu key to return to the “System Options Menu” 
on page 5-7.

Figure 5-10. Display Settings Menu
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5-7 Reset Menu 
Key Sequence: Shift, System (8) > System Options > Reset 

Factory Defaults: Press this submenu key to restore the instrument to the 
factory default values, including language, volume, brightness setting, and 
user created shortcut icons on the Menu screen. Press the Enter key to 
initiate the reset, and power-cycle the instrument.

Master Reset: In addition to the functions described in Factory Defaults 
above, all user files in the internal memory are deleted, and the original 
language and antenna files are restored. Press the Enter key to initiate the 
Master Reset and power-cycle the instrument. Press Esc to return to normal 
operation without resetting.

Update Firmware: Press this submenu key to update the instrument 
operating system with a USB flash drive. Press Enter and follow the 
onscreen instructions to update the firmware or press Esc to return to normal 
operation without updating. Refer to “Updating the LMR Master Firmware” on 
page 5-14 for additional information on firmware update.

Back: Press this submenu key to return to the “System Options Menu” 
on page 5-7.

Figure 5-11. Reset Menu
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5-8 Preset Menu 
Key Sequence: Shift, Preset (1) 

5-9 Self Test   
At power on, the LMR Master runs through a series of quick checks to ensure that the system 
is functioning properly. The System Self Test runs a series of tests that are related to the 
instrument itself. The Application Self Test runs a series of tests that are related to the 
current operating mode of the instrument. 

If the LMR Master is within the specified operating range with a charged battery, and if the 
self test fails, then contact your Anritsu Service Center (http://www.anritsu.com/Contact.asp). 

To start a self test when the system is already powered up:

1. Press the Shift key and then the System (8) key.

2. Press the Self Test submenu key. The Self Test results are displayed. 

3. Press Esc to continue.

Preset: Press this submenu key to reset the instrument to the default 
starting conditions.

Save Setup: Press this submenu key to open the Save dialog box 
(Figure 4-1) to name and save the current operating settings, allowing them 
to be recalled later to return the instrument to the state it was in at the time 
the setup was saved. 

The saved setup can be named using the touch screen keyboard. Use the  
Caps key to select an upper case letter. Use the Left/Right directional 
arrows to move the cursor position. Press Enter to save the setup.

Note: Set the File type as Setup. Refer to “Save Menu” on page 4-9 for 
details.

Recall Setup: Press this submenu key to select and recall a previously 
stored instrument setup using the “Recall Menu” on page 4-12. Use the 
rotary knob, the Up/Down arrow keys, or the touchscreen to highlight the 
saved setup, and press Enter. All current instrument settings are replaced 
by the stored setup information. 

Figure 5-12. Preset Menu
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http://www.anritsu.com/Contact.asp
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5-10 Updating the LMR Master Firmware 
The LMR Master is updated using a USB memory stick. Updated product information can be 
found on the Anritsu web site: 

http://www.anritsu.com/

Search for the product model number. The firmware updates are on the product page under 
the Library tab in the “Drivers, Software Downloads” section.      

1. Click the “Firmware Update for the LMR Master S412E” link.

2. Download and run the firmware update software:

a. Internet Explorer: Click the “Download” button and then “Run”. After the 
download is complete, press “Run” again and follow the onscreen instructions. 
Press “Help (?)” for additional information.

b. Other Browsers: Save the file locally, then run the downloaded file for the 
download folder.

3. After the firmware update is saved on the USB memory stick, eject the memory stick 
from the computer. 

4. Turn the LMR Master off and insert the USB memory stick into the LMR Master.

5. Connect the AC adapter and turn the LMR Master On.  

6.  The instrument should update automatically. Follow the instrument prompts. 

7. If the automatic update did not start, complete the following steps:

a. On the instrument press the Shift key and then the System (8) key. 

b. Press the following key sequence: System Options > Reset > Update Firmware. 
The Load Firmware menu opens.

c. Press the Load Firmware main menu key (located at the bottom-left corner of the 
instrument screen).  

d. Press the Update Application Firmware submenu key. 

e. From the choices presented, select the desired “Save” mode. 

f. Press the Enter key to begin the firmware update. 

g. Press the Enter key one more time to confirm that you want to upgrade the 
instrument firmware.

8. After the update is compete, the LMR Master will restart.

Caution

Do not turn off the instrument during the firmware update to avoid potential 
permanent damage to the instrument.

The “Release History” link provides a summary of the firmware changes.

Note

Occasionally, improvements in the VNA firmware will require a self-alignment of 
the VNA after a firmware update. Criteria for a successful self-calibration are (1) 
the instrument should be at a stable operating temperature, and (2) nothing should 
be attached to either VNA port. If a self-alignment is required, upon entering VNA 
mode the user will be promoted by a dialog box and repeating tone. Follow the 
on-screen instructions to ensure a successful self-alignment. 

http://www.anritsu.com/
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Chapter 6 — Anritsu PC Software 
Tools

6-1 Introduction
This chapter provides a brief overview of the available PC software tools from Anritsu. For 
detailed information about specific software, refer to the Anritsu web site or the program’s 
built-in Help. Software is included with the instrument and is also available from the Anritsu 
web site: http://www.anritsu.com/en-US/Services-Support/Handheld-Tools-Tool-Box.aspx.

6-2 Anritsu Tool Box
The Anritsu Tool Box is a central location to open an Anritsu measurement, visit the 
Anritsu web site, or launch several Anritsu applications. To open the Anritsu Tool Box, either 
click on the shortcut icon on the desktop or click Start and navigate through the Programs 
folder to the Anritsu folder and select Anritsu Tool Box. 

Once the Tool Box is open, move the mouse pointer over any of the application icons to view a 
short description of the application. The following pages describe three software programs 
that can be launched from the Tool Box, Line Sweep Tools, Master Software Tools (MST), and 
easyMap Tools™.

Figure 6-1. Anritsu Tool Box

http://www.anritsu.com/en-US/Services-Support/Handheld-Tools-Tool-Box.aspx


6-3 Line Sweep Tools Anritsu PC Software Tools

6-2 PN: 10580-00318  Rev. K S412E UG

6-3 Line Sweep Tools
Line Sweep Tools is a program designed to increase productivity for people who work with 
dozens of Cable traces, Antenna traces, and Passive Intermodulation (PIM) traces every day. 
Line Sweep Tools will:

• Collect sweeps from Anritsu PIM and Line Sweep gear.

• Help verify that those sweeps are done properly and that the Cable, Antenna and PIM 
sweeps meet specifications.

• Help create reports of the findings quickly and to a professional standard.

Note

The Anritsu PC Software tools do not support all of Anritsu’s handheld instruments 
or all of their measurements. Compatibility information is provided in the program’s 
Help.

Line Sweep Tools (LST) can be used for downloading and post-processing of 
certain VNA measurements and cable & antenna analysis sweeps.

Master Software Tools (MST) is primarily used for spectrum analysis 
measurements. 

Figure 6-2. Line Sweep Tools
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6-4 Master Software Tools
Anritsu Master Software Tools is a PC program for transferring and editing saved 
measurements, markers, and limit lines to a PC. MST is recommended for Spectrum 
Analyzer instruments or instruments that perform spectrum analysis measurements. 

Figure 6-3. Master Software Tools 
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6-5 easyMap Tools
easyMap Tools creates geo-referenced maps and can also convert floor plans for use by 
Anritsu mapping spectrum analyzers. It can also create single panel maps (.map) for legacy 
instruments or pan and zoom maps (.azm) for current instruments. Mapping of both 
interference and coverage is available while indoors or outdoors.

Figure 6-4. Captured Geo-referenced Map Ready for the Analyzer
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Chapter 7 — Bias Tee (Option 10)

7-1 Overview 
Option 10 provides a bias tee that is installed inside the instrument. The bias arm is 
connected to a 12 VDC to 32 VDC power source that can be turned on as needed to place the 
voltage on the center conductor of the VNA Port 2 (in VNA mode) or the center conductor of RF 
In (in SPA mode). This supply of bias is useful when conducting two-port transmission 
measurements and can also be used to provide power to block down-converters in satellite 
receivers or to power some tower-mounted amplifiers (TMAs).

Bias Tee in VNA Mode

The bias can be turned on only when the Start Frequency is 2 MHz or greater. When bias is 
turned on, the bias voltage and current are displayed in the Instrument Settings Summary 
area of the screen. The 12 VDC to 32 VDC power supply is designed to continuously deliver a 
maximum of 6 watts.

When in VNA mode, the bias tee menu can be accessed as follows:

• From the Sweep menu when in standard VNA mode:

Key Sequence: Sweep > Configure Ports > Bias Tee Setup

• From the System Options menu when VNA Field menus are selected:

Key Sequence: Shift, System (8) > Application Options > Bias Tee Setup

Bias Tee: Toggles On and Off the variable power supply.

Int Voltage P2: Use this submenu to set the power supply voltage. 

Int Current Limit P2: Use this submenu to set the power supply current. 

Back: Press this submenu key to return to the Configure Ports menu.

Figure 7-1. Bias Tee Menu
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Figure 7-2 shows how the LMR Master provides an internal voltage between 12 volts and 
32 volts that is applied to the center conductor of Port 2. That voltage would be available at 
the port along with the RF signals. 

Additional information for Option 10 is provided in the Vector Network Analyzer 
Measurement Guide (refer to Appendix A). 

Figure 7-2. Bias Tee Setup in VNA Mode
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Bias Tee in SPA Mode

When bias is turned on, the bias voltage and current are displayed in the Instrument Settings 
Summary area of the window. The 12 VDC to 32 VDC power supply is designed to 
continuously deliver a maximum of 6 watts.

The bias tee menu can be accessed from the Application Options menu in SPA mode:

System > Application Options > Bias Tee

Bias Tee: Toggles On and Off the variable power supply.

Bias Tee Voltage: Use this submenu to set the power supply voltage. 

Current: Toggle the bias tee current between Low and High.

Back: Press this submenu key to return to the Application Options menu.

Figure 7-3. Bias Tee Menu
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Figure 7-4. Bias Tee Setup in SPA Mode
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Chapter 8 — GPS (Option 31) 

8-1 Introduction    
The LMR Master is available with a built-in GPS receiver feature (Option 31) that can 
provide latitude, longitude, altitude, and UTC timing information. This option also enhances 
the frequency reference oscillator accuracy in the Spectrum Analyzer mode. Within three 
minutes of satellite acquisition, the reference oscillator will have an accuracy of better than 
50 ppb (parts per billion). 

In order to acquire data from the GPS satellites, you must have line-of-sight to the satellites, 
or the antenna must be placed outside without any obstructions. An Anritsu GPS antenna is 
required.

8-2 Activating the GPS Feature
Install the Anritsu GPS antenna onto the GPS Antenna connector on the LMR Master.

1. Press the Shift key, then the System (8) key.

2. Press the GPS submenu key.

3. Press the GPS On/Off submenu key to toggle the GPS feature on or off. When GPS is 
first turned on, a RED GPS icon appears at the top of the display.

Note
The LMR Master Technical Data Sheet provides a list of options and the 
measurements that require GPS (Option 31).

Figure 8-1. GPS Icon, Red

GPS
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4. When the GPS receiver has tracked at least three satellites, the GPS icon changes to 
GREEN. Latitude and Longitude information is displayed in the white bar on top of the 
display. Acquiring satellites may take as long as three minutes. 

5. Press the GPS Info submenu key to view information about: 

• Tracked Satellites

• Latitude and Longitude

• Altitude

• UTC

• Fix Available

• Almanac Complete

• Antenna and Receiver Status

• GPS Antenna Voltage and Current

Refer to Section 8-4 “GPS Menu” on page 8-3 for details about the GPS Info dialog box.

6. Press the Reset submenu key to reset the GPS.

7. The GREEN GPS icon with a RED CROSS through it, as shown below, appears when 
GPS satellite tracking is lost (after actively tracking 3 or more satellites). The GPS 
longitude and latitude are saved in the instrument memory until the LMR Master is 
turned off or until GPS is turned off by using the GPS On/Off key.

Figure 8-2. GPS Icon, Green

Figure 8-3. GPS Icon, Tracking Lost

GPS

GPS
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8-3 Saving and Recalling Traces with GPS Information

Saving Traces with GPS Information

The GPS coordinates of a location can be saved along with a measurement trace. Refer to the 
“Save Menu” on page 4-9 for more information. The current GPS coordinates are saved with 
the measurement traces whenever GPS is on and actively tracking satellites.

Recalling GPS Information

If the GPS coordinates were saved with a measurement, then when the measurement is 
recalled, the coordinates that were saved are recalled as well. Refer to the “Recall Menu” 
on page 4-12 for more information about recalling a saved trace.

8-4 GPS Menu 
Key Sequence: Shift, System (8) > GPS 

GPS: Press this submenu key to turn GPS on or off.

GPS Info: Press this submenu key to display the current GPS information. 
Refer to “GPS Info” on page 8-4.

GPS Voltage: Press this submenu key to set the source voltage to be either 
3.3 V or 5 V depending on the GPS receiver being used. GPS antenna 
voltage is set to 3.3 V by default in order to prevent accidental damage to 
lower-voltage GPS antennas.

5 V is the recommended setting for Anritsu GPS antennas. 

Reset: Press this submenu key to set the number of tracked satellites to 0 
and to erase any almanac data, along with saved coordinates. The process 
of searching for and reacquiring satellites begins again.

Back: Press this submenu key to return to the “System Menu” on page 5-4.

Figure 8-4. GPS Menu
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GPS Info

• Tracked Satellites 

Shows the number of tracked satellites (three are required to retrieve latitude and 
longitude, four are required to resolve altitude). Generally, the larger number of 
satellites tracked, the more accurate the information.

• Latitude and Longitude 

Shows location in degrees, minutes, and seconds.

• Altitude 

Shows altitude information in meters.

• UTC 

Universal Coordinated Time.

• Fix Available 

The cold start search sets are established to ensure that at least three satellites are 
acquired within the first couple of minutes. When three satellites are found, the 
receiver computes an initial fix (typically in less than two minutes). Fix Not Available 
means that the initial position has not been established.

• Almanac Complete 

The system Almanac contains information about the satellites in the constellation, 
ionospheric data, and special system messages. In a cold start, the GPS receiver does 
not have any navigation data so the receiver does not have a current almanac. A 
complete system almanac is not required to achieve a first position fix. The availability 
of the almanac, however, can significantly reduce the time to first fix.

• Antenna Status 

OK: Antenna is connected properly and antenna is working properly

Short/Open: A short or open exists between the antenna and the connection. If this 
message is displayed, then remove and replace the GPS antenna. If the message 
persists, then try another Anritsu GPS antenna. If the message persists, then contact 
your nearest Anritsu Service Center.

• Receiver Status 

Current status of the receiver.

• GPS Antenna Voltage and Current 

Shows voltage and current.
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Appendix A — Measurement Guides

A-1 Introduction  
This appendix provides a list of supplemental documentation for LMR Master features and 
options. Measurement guides are available as PDF files on the documentation disc and the 
Anritsu Website (http://www.anritsu.com). 

Table A-1. Measurement Guides for Analyzers and Analyzer Options 

LMR Master Feature (Available Option) Document and Part Number

Vector Network Analyzer 
VNA Bias-Tee (0010)
Vector Voltmeter (0015)
Distance Domain

Vector Network Analyzer 
Measurement Guide (10580-00289)

High-Accuracy Power Meter (0019) Power Meter Measurement Guide 
(10580-00240)

Spectrum Analyzer
Interference Analyzer (0025)
Channel Scanner (0027)
Coverage Mapping (0431)
AM/FM/PM Analyzer (0509)
EMF Measurements (0444)

Spectrum Analyzer Measurement Guide 
(10580-00349)

LTE RF Measurements (0541)
LTE Modulation Quality (0542)
LTE OTA Measurements (0546)
EMF Measurements (0444)

3GPP Signal Analyzer 
Measurement Guide (10580-00234)

Fixed WiMAX RF Measurements (0046)
Fixed WiMAX Demodulation (0047)
Mobile WiMAX RF Measurements (0066)
Mobile WiMAX Demodulation (0067)
Mobile WiMAX Over-the-Air Measurements (0037)

WiMAX Signal Analyzer 
Measurement Guide (10580-00236)

NBFM Analyzer
P25/P25p2 Analyzer (0521)
P25/P25p2 Coverage (0522)
NXDN Analyzer (0531)
NXDN Coverage (0532)
DMR 2 Analyzer (0591)
DMR 2 Coverage (0592)
PTC Analyzer (0721)
PTC Coverage (0722)
TETRA Analyzer (0581)
TETRA Coverage (0582)

Land Mobile Radio Measurement Guide
(10580-00243)

http://www.anritsu.com
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A complete suite of computer software applications are available for download: 

http://www.anritsu.com/en-US/Services-Support/Handheld-Tools-Tool-Box.aspx 

Table A-2. LMR Master-Related Documents

LMR Master Related Documents Related Document and Part Number

Performance Specifications LMR Master Technical Data Sheet 
(11410-00486)

SCPI Programming Manual LMR Master Programming Manual 
(10580-00319)

http://www.anritsu.com/en-US/Services-Support/Handheld-Tools-Tool-Box.aspx
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Appendix B — Error Messages

B-1 Introduction
This appendix provides a list of information and error messages that could be displayed on 
the LMR Master. If any error condition persists, then contact your local Anritsu Service 
Center. 

B-2 Reset Options
You can reset your LMR Master to Factory Defaults or use a Master Reset to return to the 
FULL Factory Default condition from the menu system or from the Off condition.

Reset Via Instrument Menus

From the LMR Master menu system, press the Shift key, then the System (8) key to open the 
System menu. Then press the System Options submenu key to open the System Options 
menu. Then press the Reset submenu key to open the Reset menu (refer to section 
“Reset Menu” on page 5-12). From the Reset menu, press either the Factory Defaults 
submenu key or the Master Reset submenu key. 

Reset from OFF Condition

You can also reset the LMR Master by turning it Off and then restarting under one of the 
following conditions:

Factory Defaults Reset:

Hold the Esc button while pressing the On/Off button. Continue holding the Esc button until 
the Anritsu splash screen appears. You can then release the button. The LMR Master starts 
up with many Factory Default settings (refer to section “Factory Defaults” on page 5-12). 
Throughout this appendix, this sequence is abbreviated as Factory Defaults (Esc+On).

Master Reset:

Hold the 8 key in the number keypad (also referred to as the System (8) key) while pressing 
the On/Off button. Continue holding the 8 key until the Anritsu splash screen appears. You 
can then release the key. The LMR Master starts up in FULL Factory Default condition (refer 
to section “Master Reset” on page 5-12). Throughout this appendix, this sequence is 
abbreviated as Master Reset (System+On).
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B-3 Self Test
To run self test, press Shift and System (8) and then Self Test. Refer to the results window in 
Figure B-1, which summarizes the status of several key functions in the instrument that are 
common to all applications (note that your instrument display may differ from this image). 
If any subtest shows FAILED, then check that the battery level is adequate for operation, 
or check that the temperature is within acceptable limits. Reset to factory defaults with 
either Factory Defaults (Esc+On), or Master Reset (System+On). 

Caution 
Use of Master Reset (System+On), will erase all user saved setups and 
measurement traces and will return the LMR Master to a full Factory Default 
condition. If the error persists, then contact your Anritsu Service Center.

Figure B-1. Self Test Results Window 
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Application Self Test

VNA Mode Self Test (Vector Network Analyzer mode only)

To run the application self test, press Shift and System (8) and then Application Self Test from 
within the desired mode. When you are in Vector Network Analyzer mode, you will see the 
results window that is shown in Figure B-2 (note that your instrument display may differ 
from this image), which summarizes the status of several key functions that are specific to 
this application. 

If the Overall Status shows Failed, then one or more elements of the Application Self Test 
have failed. This self test consists of 2 subtests:

Frequency Sweep: Lists any frequency range over which errors in the sweep are occurring

EEPROM: Indicates whether reading or writing (or both) to the EPPROM has failed

If any of the subtests shows FAILED, then check that the battery level is adequate for 
operation or that temperature is within acceptable limits. Reset to factory defaults with 
either Factory Defaults (Esc+On), or Master Reset (System+On). 

Figure B-2. Application Self Test

Caution 
Use of Master Reset (System+On), will erase all user saved setups and 
measurement traces and will return the LMR Master to a full Factory Default 
condition. If the error persists, then contact your Anritsu Service Center.
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Spectrum Analyzer Mode Self Test 

CW Signal Generator Mode Self Test 

Figure B-3. Application Self Test 

Figure B-4. Application Self Test 
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NBFM, P25/P25p2, NXDN, DMR 2, PTC, and TETRA Self Test 

Figure B-5. Application Self Test
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B-4 Operation Error Messages

Fan Failure

The system has determined that the fan should be running due to the internal temperature of 
the unit, but cannot detect that the fan is actually running. 

It is important to keep the fan inlet and exhaust ports clear of obstructions. The cooling fan 
will vary the speed in relation to the internal temperature of the instrument (refer to 
Figure B-6). The fan will turn on at low speed when the internal temperature of the 
instrument reaches 44ºC, and will increase the fan speed to maximum at 54ºC. As the 
internal temperature of the instrument decreases, the fan will reduce speed until the 
temperature reaches 39ºC, at which point the fan will turn off.

High Temp Warning

The internal temperature has reached an excessive level, 85ºC. Verify that the ventilation 
openings are unobstructed and that the fan is running. Internal temperatures may be 
manually verified by using the SELF TEST function. Turn off the unit and allow the 
temperature to cool down. If the fault is not resolved and the internal temperature reaches 
90ºC, then a countdown of 10 seconds will begin. The countdown gives the user a chance to 
save the current setup before the instrument turns itself off (before internal temperatures 
can cause any damage). If the error persists after removing any obstructions and allowing the 
unit to cool, then reset to the factory defaults with Factory Defaults (Esc+On), or 
Master Reset (System+On). 

Note
Measurement mode specific error messages are listed in the Measurement 
Guides. Refer to Appendix A.

Figure B-6.  Fan Speed vs. Temperature

Caution 
Use of Master Reset (System+On), will erase all user saved setups and 
measurement traces and will return the LMR Master to a full Factory Default 
condition. If the error persists, then contact your Anritsu Service Center.
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Operation not Permitted in Recall Mode

Attempted to perform an operation on a recalled trace. Many operations are valid only on a 
live or active trace.

Power Supply 

Power Supply failed. Charge the battery.

Error Saving File. General Error Saving File 

An error was detected while saving a file. Try again. 
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Appendix C — Tower Mounted 
Amplifiers

C-1 Introduction 
A Tower Mounted Amplifier (TMA) can be used to amplify the received signal. There are 
different types of TMA depending on the system requirements. Three commonly used types 
are:

• TMA-D: A duplex tower mounted amplifier that combines transmit and receive ports 
from the radio system and connects to a single antenna. This configuration is specific to 
systems that use a single antenna configuration.

• TMA-S: A receive-only tower mounted amplifier is installed between the receiving 
antenna and the radio to boost weak signals. This configuration is common on systems 
that implement separate antennas for transmitting and receiving.

• TMA-DD: A dual-duplex tower mounted amplifier used for radios systems with a single 
transmission line connection for transmit and receive. These systems are commonly 
called transceivers.

Figure C-1. Tower Mounted Amplifiers



C-1 Introduction Tower Mounted Amplifiers

C-2 PN: 10580-00318  Rev. K S412E UG



S412E UG PN: 10580-00318  Rev. K D-1

Appendix D — Glossary of Terms

D-1 Introduction
The following terms are related to this product and its technology.

D-2 Glossary of Terms
3GPP : The 3rd Generation Partnership Project (3GPP) is a collaboration 

agreement that was established in December, 1998. It is a co-operation 
between ETSI (Europe), ARIB/TTC (Japan), CCSA (China), ATIS 
(North America), and TTA (South Korea). The scope of 3GPP was to 
make a globally applicable third generation (3G) mobile phone system 
specification within the scope of the ITU’s IMT-2000 project. 3GPP 
specifications are based on the evolved GSM specifications, now 
generally known as the UMTS system. 

 

Adapter : A fitting that supplies a passage between two sets of equipment when 
they cannot be directly interconnected. 

 

Adaptive Array
Antenna : Adaptive array antenna is a type of advanced ’smart’ antenna 

technology that continually monitors a received signal and dynamically 
adapts signal patterns to optimize wireless system performance. The 
arrays use signal processing algorithms to adapt to user movement, to 
changes in the radio-frequency environment, and to multi-path and 
co-channel interference. 

 

ADC : Analog-to-Digital Converter (ADC, A/D or A to D) is an electronic device 
that converts continuous signals to discrete digital numbers. The 
reverse operation is performed by a digital-to-analog converter (DAC). 
ADC can uniquely represent all analog input values within a specified 
total input range by a limited number of digital output codes. Refer also 
to DAC. 

 

Adjacent Channel : Adjacent Channel is a channel or frequency that is directly above or 
below a specific channel or frequency. First-adjacent is immediately 
next to another channel, and second-adjacent is two channels away, and 
so forth. Information on adjacent channels is used in keeping stations 
from interfering with one another. 

 

Adjacent channel
interference : Adjacent channel interference refers to signal impairment to one 

frequency due to the presence of another signal on a nearby frequency. 
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AM : Amplitude Modulation (AM) uses amplitude variation in proportion to 
the amplitude of the modulating signal, and is usually taken as DSB-LC 
(Double-Sideband Large Carrier) for commercial broadcast 
transmissions and DSB-SC (Double-Sideband Suppressed Carrier) for 
multiplexed systems. 

 

AMC : Adaptive Modulation and Coding (AMC) is an alternative link 
adaptation method in 3G mobile wireless communication. AMC 
provides the flexibility to match the modulation-coding scheme to the 
average channel conditions for each user. With AMC, the power of the 
transmitted signal is held constant over a frame interval, and the 
modulation and coding format is changed to match the current received 
signal quality or channel conditions. 

 

Analog System : An Analog system uses an analog transmission method to send voice, 
video and data-using analog signals, such as electricity or sound waves, 
that are continuously variable rather than discreet units as in digital 
transmissions. Mobile analog systems include AMPS, NMT and 
ETACS. 

 

Analog
Transmission : Analog Transmission refers to signals propagated through the medium 

as continuously varying electromagnetic waves. 

 

Antenna : Antenna is a device which radiates and/or receives radio signals, 
including RF, microwave, and RADAR. 

 

Antenna
beamwidth : Antenna beamwidth, also known as the half-power beamwidth, is the 

angle of an antenna pattern or beam over which the relative power is at 
or above 50% of the peak power. 

 

Antenna Directivity : Antenna directivity, also known as antenna gain, is the relative gain of 
the main beam of an antenna pattern to a reference antenna, usually an 
isotropic or standard dipole. Antenna Directivity is the percentage of 
radiated signal transmitted or received in a given direction related to 
beamwidth. 

 

Antenna Efficiency : Antenna Efficiency is the percentage of theoretical gain actually 
realized from an antenna. 
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Antenna Gain : Antenna gain, also known as antenna directivity, is the relative gain of 
the main beam of an antenna pattern to a reference antenna, usually an 
isotropic or standard dipole. Antenna Gain is the effectiveness of a 
directional antenna expressed as the ratio of input power of the 
directional antenna to input power of an isotropic radiator to provide 
the same field strength in the desired direction. Sometimes related to a 
dipole antenna. 

 

Antenna, Isotropic : An isotropic antenna is a theoretical point source radiating a spherical 
power envelope. 

 

Antenna, Parabolic : A parabolic antenna is an antenna utilizing a reflector that is shaped as 
a paraboloid in order to both concentrate the radiated signal into a 
beam and to provide considerable gain. Beamwidth varies inversely and 
gain varies directly with the size of the antenna and with frequency. 

 

Attenuation : Attenuation refers to decreasing in signal magnitude between two 
points. These points may be along a radio path, transmission line or 
other devices. 

 

Attenuator : Attenuator is a device specifically designed to decrease the magnitude 
of a signal transmitted through it. 

 

Average power : Average power is the peak power averaged over time and is usually 
applied to pulsed systems where the carrier power is switched on and 
off. 

 

Band Pass Filter : A Band Pass Filter is a radio wave filter with a specific range of 
frequencies in which it is designed to pass. It rejects frequencies outside 
the pass-band range. A resistor-inductor-capacitor circuit is an example 
of a Band Pass Filter. 

 

Bandwidth : Bandwidth usually identifies the capacity of a circuit or amount of data 
that can be sent through a given circuit. It may be user-specified in a 
PVC. It is an indication of the amount of data that is passing over a 
medium. Also, bandwidth is the portion of the frequency spectrum 
required to transmit desired information. Each radio channel has a 
center frequency and additional frequencies above and below this 
carrier frequency which is used to carry the transmitted information. 
The range of frequencies from the lowest to the highest used is called 
the bandwidth. 
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BER : Bit Error Rate or Bit Error Ratio (link quality specification/testing) 
(BER) is a measure of transmission quality. The ratio of error bits to the 
total number of bits transmitted. A bit error rate of 10-6 refers to an 
average of one error per million bits. It is generally shown as a negative 
exponent, (for example, 10-7 which means 1 out of 107 bits are in error 
or 1 out of 10,000,000 bits are in error). Bit Error Rate is the fraction of 
a sequence of message bits that are in error. 

 

BERT : Bit Error Rate Test/Tester (BERT) is a test that gauges the quality of 
the T1 or digital line. By sending a known pattern to another device 
across the span, the far end device can compare incoming pattern to its 
own, thereby indicating bit errors on the line. 

 

Bias Tee : A three-port network used to supply an isolated DC signal. 

 

Broadband : Broadband refers to telecommunication that provides multiple channels 
of data over a single communications medium, typically using some 
form of frequency or wave division multiplexing. It is a service or 
system requiring transmission channels capable of supporting rates 
greater than the Integrated Services Digital Network (ISDN) primary 
rate. 

 

C/I : Carrier-to-Interference ratio (C/I) is the ratio of power in an RF carrier 
to the interference power in the channel. 

 

Carrier Frequency : Carrier Frequency refers to the nominal frequency of a carrier wave, the 
frequency of the unmodulated electrical wave at the output of an 
amplitude modulated, the center frequency of a frequency modulation 
signal, frequency modulated, or phase modulated transmitter of the 
output of a transmitter when the modulation is zero. 

 

Coaxial Cable : Coaxial Cable (Coax) is a type of electrical communications medium 
used in the LAN environment. This cable consists of an outer conductor 
concentric to an inner conductor, separated from each other by 
insulating material, and covered by some protective outer material. 
This medium offers large bandwidth, supporting high data rates with 
high immunity to electrical interference and a low incidence of errors. 
Coax is subject to distance limitations and is relatively expensive and 
difficult to install. 

 

Coupler : A coupler is a passive device used to split or combine a transmission 
line. 
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CW : Continuous Wave (CW) 

 

DANL : Displayed Average Noise Level (DANL): Displayed average noise level 
is sometimes confused with the term Sensitivity. While related, these 
terms have different meanings. Sensitivity is a measure of the 
minimum signal level that yields a defined signal-to-noise ratio (SNR) 
or bit error rate (BER). It is a common metric of radio receiver 
performance. Spectrum analyzer specifications are always given in 
terms of the DANL. One of the primary uses of a spectrum analyzer is to 
search out and measure low-level signals. The limitation in these 
measurements is the noise generated within the spectrum analyzer 
itself. This noise, generated by the random electron motion in various 
circuit elements, is amplified by multiple gain stages in the analyzer 
and appears on the display as a noise signal. On a spectrum analyzer, 
this noise is commonly referred to as the Displayed Average Noise 
Level, or DANL 1. While there are techniques to measure signals 
slightly below the DANL, this noise power ultimately limits our ability 
to make measurements of low-level signals. 

 

dB : Decibel or deciBel (dB) is a unit for measuring relative power ratios in 
terms of gain or loss. The units of dB are expressed in terms of the 
logarithm to base 10 of a ratio and typically are expressed in watts. For 
example, a -3dB loss indicates a 50% loss in power; a +3dB reading is a 
doubling of power; 10 dB indicates an increase (or a loss) by a factor of 
10; 20 dB indicates an increase (or a loss) of a factor of 100; 30 dB 
indicates an increase (or a loss) by a factor of 1000. 

 

dBc : Decibels referenced to the carrier (dBc) is a technique for expressing a 
power measurement in logarithmic form using the carrier power as a 
reference. The units are used to describe how far down signals and noise 
are relative to a known signal. Typical use of this term is to describe 
spurious signals and noise compared to a desired transmit signal. 

 

dBm : dBm is a decibel value referenced to a milliWatt (dBm). This is a 
technique for expressing a power measurement in logarithmic form 
using 1 mW as a reference. dBm is a decibel ratio (log 10) of Watts (W) 
to one milliwatt (1mW). dBm, therefore, represents absolute power. 

 

Demodulate : To extract information from a transmitted (modulated) signal. 

 

Demodulor : A device that extracts information from a transmitted (modulated) 
signal. 
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Deviation : The difference between signal parameters (generally in frequency 
modulated signals, the difference between the maximum modulated 
frequency and the base carrier frequency). 

 

DHCP : Dynamic Host Configuration Protocol (DHCP) 

 

Directional Coupler : A Directional Coupler is a device to split an incident transmission into 
two separate paths, and to absorb reflections from the sampled 
(coupled) line. 

 

Discriminator : A Discriminator is a demodulation circuit that is used to recover the 
modulation from frequency modulated signals. A Discriminator 
responds to frequency variations. 

 

Distributed antenna
system : Distributed antenna system is a type of antenna system that is 

distributed or remotely located away from the transmitter. Such an 
antenna or series of antennas can be connected via coaxial cable, leaky 
feeder, or optical fiber link. 

 

DMR : Digital Mobile Radio (DMR) 

 

DSP : Digital Signal Processing (DSP) 

 

Duplex : Duplex refers to two way communication. 

 

EMF : Electromagnetic Field 

 

Flash Memory : Flash memory is a non-volatile solid state storage device that is 
packaged as a chip. It can be electrically erased and reprogrammed. T is 
primarily used in memory cards, USB flash drives, MP3 players, and 
solid-state drives for general storage and transfer of data between 
computers and other digital products. Is a specific type of EEPROM 
(electrically erasable programmable read-only memory) that is erased 
and programmed in large blocks. 

 

FM : Frequency Modulation (FM) is a form of angle modulation in which the 
instantaneous frequency of a sine-wave carrier is caused to depart from 
the carrier frequency by an amount proportional to the instantaneous 
value of the modulating wave. In FM, signals of different frequencies 
represent different data values. 
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FM Modulation
Index : In FM modulated systems, the FM Modulation Index is the ratio of the 

peak frequency deviation to the maximum modulating frequency. The 
higher the index, the greater the received quality. M Modulation Index 
= (peak frequency deviation / maximum modulation frequency) 

 

FM Threshold : FM Threshold is the point at which the input signal power is just strong 
enough to enable the receiver demodulator circuitry to successfully 
detect and recover a good quality television picture from the incoming 
video carrier. 

 

GPS : The Global Positioning System (GPS) is a space-based global navigation 
satellite system (GNSS) that provides reliable location and time 
information in all weather and at all times when and where an 
unobstructed line of sight is available to four or more GPS satellites. 
The system is maintained by the United States government and is 
freely accessible by anyone with a GPS receiver. The Global Positioning 
System is making it possible for people using ground receivers to 
determine their geographic location within 10 to 100 meters. The 
satellites use simple mathematical calculations to broadcast 
information that is translated as longitude, latitude, and altitude by 
Earth-based receivers. 

 

Graticule : A reticle or grid. 

 

IQ : In-phase and Quadrature (IQ) or (I/Q) IQ is a method of representing 
digital modulation. Ll baseband signals can be represented by an I 
(In-Phase) portion and a Q (Quadrature-Phase) portion. Vectors 
describe the I and Q states (or equivalently the amplitude and phase) of 
a signal, so that all possible information about that signal can be 
derived from them. I text files contain pairs of I/Q values for signals 
that they represent. IQ odulators are 90 degrees out of phase with each 
other. IQ dulation combines two channels of information into one signal 
and then separates them later. 

 

LMR : Land Mobile Radio 
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LTE : Long Term Evolution (LTE), sometimes also referred to as 3G LTE or 
Super-3G, is the 3GPP radio technology evolution architecture. Its full 
name is UTRA-UTRAN Long Term Evolution (LTE) and 3GPP System 
Architecture Evolution (SAE). TE refers to a mobile technology upgrade 
path for 3G networks that will provide faster data speeds and new 
services through new radio access technology optimized for IP-based 
traffic. E is part of the GSM evolutionary path beyond 3G, following 
EDGE, UMTS/W-CDMA, and HSPA (HSDPA and HSUPA combined). L 
uses Orthogonal Frequency Division Multiple Access (OFDMA) on the 
downlink to achieve high peak data rates in high spectrum bandwidth. 
LT systems will coexist with 3G systems as well as 2G systems. Mul 
mode devices will likely function across LTE/3G or even LTE/3G/2G, 
depending on market circumstances. 

 

LVD : Low Voltage Directive (LVD) 

 

NBFM : Narrow Band Frequency Modulation 

 

NF : Noise Figure (NF) is a measure of degradation of the signal-to-noise 
ratio (SNR) that is caused by components in a radio frequency (RF) 
device. The noise factor (F) of a system is defined as the signal-to-noise 
ratio of the input power of the system divided by the signal-to-noise 
ratio of the output power of that system. F (the noise figure) is defined 
as the decibel value of the noise factor. = 10log (F) where log uses the 
base 10, or common log. T s formula is valid only then the input 
termination is at standard noise temperature. 

 

NXDN : A narrowband frequency-domain multiple access communication 
protocol. 

 

OBW : Occupied Bandwidth (OBW) is a measure of the bandwidth containing 
99% of the total integrated power of the transmitted spectrum, centered 
on the assigned channel frequency. Interference to other channels or to 
other systems can occur if OBW is too large. 

 

OSL : Open Short Load 

 

OSL : Open Short Load Through 
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OTA : Over The Air (OTA): OTA refers generally to any transfer of information 
or signal that takes place in a wireless environment, rather than using 
a wired connection. OTA is usually used in connection with a standard 
defining the provisioning of mobile devices and applications, such as 
downloading or uploading content or software, and commonly used in 
conjunction with the Short Messaging Service (SMS). SMS OTA 
Messages contain information that is used to configure the settings of a 
WAP browser in a mobile phone (refer to SMS and WAP). 

 

P25 : An set of open interface communication standards. 

 

PTC : Positive Train Control (PTC) is a system that provides railway safety 
for trains and workers. The American Railway Engineering and 
Maintenance-of-Way Association (AREMA) organization describes PTC 
as having the following primary characteristics: 1] train separation for 
collision avoidance, [2] enforcement of line speeds, [3] temporary speed 
restrictions, and safety of wayside rail workers. Ing PTC, movement 
authority and train location (via GPS) are available by utilizing wireless 
technologies. 

 

SINAD : Signal-to-Noise And Distortion (ratio) (SINAD) 

 

TETRA : Terrestrial Trunked Radio (TETRA) (new name) 

 

TFT : Thin-Film Transistor/Thin-Film Technology (TFT) 

 

TMA : A Tower Mounted Amplifier (TMA) amplifies signals from an antenna 
to reduce the noise figure of a base transceiver station (BTS). This helps 
to improve the overall sensitivity of the BTS. A TMA is a low-noise 
amplifier (LNA) that is usually mounted as close as practical to the 
antenna in Base Transceiver Stations or in mobile masts. When using a 
TMA, the antenna is able to receive weaker signals. 

 

TTL : Transistor-Transistor Logic (TTL) 

 

VSWR : Voltage Standing Wave Ratio (VSWR) 
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WiMax : Worldwide Interoperability for Microwave Access (WiMax), is a popular 
name of the 802.16 wireless metropolitan-area network standard, 
including both 802.16-2004 for fixed WiMAX and 802.16-2005 for mobile 
WiMAX. WiMax has a range of up to 31 miles. Data rates for WiMax 
can reach up to 75 Mbps (Fixed) or 15 Mbps (Mobile). A number of 
wireless signaling options exist ranging anywhere from the 2 GHz 
range up to 66 GHz. WiMax is primarily aimed at making broadband 
network access widely available without the expense of stringing wires 
(as in cable-access broadband) or the distance limitations of Digital 
Subscriber Line. WiMax technology can deliver high-speed Internet 
access to rural areas and other locations. WiMax also offers an 
alternative to satellite Internet services. 
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